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About this document

This document explains how to connect products of the PolyWorks Metrology Suite to 
PolyWorks|DataLoop using a PolyWorks|DataLoop license.

The main concepts covered in this guide include setting up Microsoft SQL Server, the file 
storage, the PolyWorks|DataLoop server system, and secure communications. This document 
also explains how to set up and upgrade the server and client applications, activate the 
PolyWorks|DataLoop license, as well as how to configure and manage a DataLoop server.

The appendices also provide more detailed information about the upload of existing data to 
PolyWorks|DataLoop, file storage management, and Microsoft SQL Server maintenance, as 
well as the authentication and configuration of compatible identity providers.
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Technical support

Aside from the present document, InnovMetric Software Inc. does not provide support to set 
up Microsoft SQL Server. For support on setting up Microsoft SQL Server, contact the Microsoft 
SQL Server support team.

Ongoing maintenance and backup of the database are also required. Note that InnovMetric 
Software Inc. does not offer this service.

For information on functionalities offered in PolyWorks products, contact the Technical Support 
team of your PolyWorks provider.
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1. Overview of PolyWorks|DataLoop 

1.1 PolyWorks|DataLoop three-tier architecture
To use PolyWorks|DataLoop, a network infrastructure must be set up with potentially multiple 
servers. The number of servers and their configurations depend on the number of users that 
are expected to interact with the servers.

The following schema shows how PolyWorks applications communicate with one another as 
well as with Microsoft SQL Server. 

1.2 Server applications
PolyWorks|DataLoop requires that certain server applications be installed and configured. The 
following subsections provide a description of each server application and information on how 
to obtain their requirements.

1.2.1 PolyWorks|DataLoop Core

PolyWorks|DataLoop Core enables PolyWorks Metrology Suite users to store and manage 
PolyWorks data, such as inspection projects, on the database server. PolyWorks Metrology 
Suite users must be connected to PolyWorks|DataLoop Core in order to have access to 
PolyWorks data stored on the server. Note that PolyWorks|DataLoop Web Interface Server and 
PolyWorks|ReportLoop for Excel (DataLoop) also connect to PolyWorks|DataLoop Core.
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1.2.2 PolyWorks|DataLoop Web Interface Server

PolyWorks|DataLoop Web Interface Server is an application that allows users to access 
PolyWorks data stored on PolyWorks|DataLoop from their web browser and mobile device 
through the following client applications: 

 PolyWorks|DataLoop Web Interface using their web browser

 PolyWorks|DataLoop Mobile Interface installed on a supported mobile device

1.2.3 PolyWorks|ReportLoop Server for Excel

PolyWorks|ReportLoop Server for Excel is an application that is used to give users of the 
PolyWorks|ReportLoop for Excel (DataLoop) client application access to PolyWorks data stored 
on PolyWorks|DataLoop.

1.2.4 PolyWorks Collaborative Suite License Server

PolyWorks Collaborative Suite License Server is a web-based application used to manage 
licenses for PolyWorks Collaborative Suite products (i.e., PolyWorks|PMI+Loop and 
PolyWorks|DataLoop). 

To use PolyWorks|DataLoop, users need to obtain licenses from the license server and remain 
connected to the license server.

The current document presents the main instructions related to the installation and the online 
registration of the Collaborative Suite License Server. For more information on the 
requirements, the offline registration, or the administration instructions, see the PolyWorks 
Collaborative Suite License Server Installation Guide (.pdf) available on the Help menu of the 
application or on MyPolyWorks.

1.3 Client applications

1.3.1 The PolyWorks Metrology Suite

When the PolyWorks Metrology Suite is connected to PolyWorks|DataLoop, users have access 
to the PolyWorks data stored on PolyWorks|DataLoop (i.e., workspaces, projects, and pieces). 
This interconnects all the users to the 3D measurement data and results.

The main actions a user can perform with the data managed using PolyWorks|DataLoop are 
searching, opening, creating, viewing, editing, and uploading. The user can also specify the 
properties, security policy, maximum PolyWorks version, and data retention policy associated 
with the data.

Once created or modified data is uploaded to PolyWorks|DataLoop, other users can access it 
according to their permissions.
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1.3.2 PolyWorks|DataLoop Web Interface

The PolyWorks|DataLoop Web Interface allows users to access and review all the PolyWorks 
inspection data stored in PolyWorks|DataLoop. Any device with access to the company 
network and to a web browser can be used to log in.

The interface centralizes data monitoring with the use of dashboards and widgets that are 
tailored to display key outputs. Users can search keywords related to the project properties or 
browse through all inspection projects to access completed inspections and review 
measurement results, along with reports and control views. Project discussions with colleagues 
can also facilitate collaborative work. 

1.3.3 PolyWorks|DataLoop Mobile Interface

The PolyWorks|DataLoop Mobile Interface allows users to monitor 3D measurement activities 
and open any inspection project in 3D from a mobile device or tablet.

With PolyWorks|DataLoop Mobile Interface, users can log in and connect to 
PolyWorks|DataLoop Web Interface server to perform the following tasks:

 Search for inspection projects by name or property.

 View and search for piece inspection results and formatted reports.

 View and navigate the color-mapped 3D model.

1.3.4 PolyWorks|ReportLoop for Excel (DataLoop)

PolyWorks|ReportLoop for Excel (DataLoop) is an Excel-based reporting solution that 
integrates smart and updatable 3D inspection data within your preformatted corporate report 
spreadsheets by directly linking spreadsheet cells to PolyWorks|DataLoop. 

With this add-in, users can inject PolyWorks formulas into Excel spreadsheet cells to retrieve 
data from PolyWorks|Inspector project, piece and object properties, as well as controls and 
control properties. Cells can then be updated when a new version of the object is uploaded. 
Powerful query functions also allow users to gain knowledge about the database, which offers 
key insights, and to create useful monitoring graph and dashboards. 

1.3.5 PolyWorks|ReportLoop for Power BI

PolyWorks|ReportLoop for Power BI is a connector that allows users to bring inspection data 
from a PolyWorks|DataLoop server into Power BI, where they can use its powerful query editor 
to edit, format, and organize the data and display it using powerful visualization tools. In 
addition to that, PolyWorks|ReportLoop for Power BI is fully compatible with Microsoft’s 
official on-premises data gateway, which allows users to perform periodic updates of their 
reports.
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1.3.6 PolyWorks|DataLoop API 

PolyWorks|DataLoop API can be used with almost every programming language that can 
support PolyWorks|DataLoop API calls, and allows you to access PolyWorks|DataLoop data by 
using HTTPS/REST principles. API clients have the possibility to have various data 
representations by using HTTP messages. 

Like any other PolyWorks|DataLoop application, a valid license is required for the user to get 
access to the data, even through the API Endpoint. Authentication and authorization are 
required to protect data stored on PolyWorks|DataLoop. PolyWorks|DataLoop uses the OAuth 
2.0 and OpenID Connect standard protocol to rely on proven techniques and allow external 
provider integration in the future. Personal access tokens (PAT) can also be generated. The 
system ensures that the data accessed through the PolyWorks|DataLoop API remains at the 
same security level as the other client applications. 

1.4 How licenses are managed
A PolyWorks|DataLoop license is required for each user who connects to 
PolyWorks|DataLoop. A license that is assigned to a user can be taken back, if it is unused for 
30 consecutive days, to make it available to other users.

1.5 How users are managed
PolyWorks|DataLoop users are defined and managed in PolyWorks|DataLoop Core 
Administrator. Only one list of users must be managed. PolyWorks|DataLoop currently 
supports Windows users (defined in the Active Directory domain), DataLoop users, created 
exclusively for PolyWorks|DataLoop, and users from compatible identity providers.

1.6 How security is managed
PolyWorks|DataLoop server applications should be installed on premises or on a trusted cloud 
provider (e.g., Azure, AWS, Google Cloud, etc.), and should be protected by a firewall to 
guarantee full security.

PolyWorks|DataLoop server applications connect using the standard HTTPS encrypted 
protocol. This protocol is used to manage transactions between applications.

PolyWorks|DataLoop server applications support the use of a reverse proxy with or without 
authentication.

1.7 Information collected by InnovMetric
When the PolyWorks Collaborative Suite License Server application is connected to the 
internet, InnovMetric Software Inc. retrieves information on the number of users and devices 
per country, as well as the number of licensed and occasional users, in order to distribute 
revenues with its subsidiaries. This is the only information that is collected, and it is solely used 
for that purpose. 
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2. Requirements

2.1 PolyWorks software program compatibility
PolyWorks|DataLoop is part of the PolyWorks ecosystem. Each software product included in 
this ecosystem has its own release, which may contain new tools, improvements to existing 
tools, and fixed issues.

Compatible versions of these software components must be installed.

2.1.1 Interoperability with the PolyWorks Metrology Suite

To be able to connect to PolyWorks|DataLoop from a PolyWorks Metrology Suite application, 
you must ensure that your DataLoop server version is compatible with the version of your 
PolyWorks Metrology Suite applications. The interoperability matrix below shows which 
PolyWorks|DataLoop version is compatible with each PolyWorks Metrology Suite version. 

2.1.2 Interoperability with PolyWorks|DataLoop Mobile Interface 

PolyWorks|DataLoop Mobile Interface is compatible with PolyWorks|DataLoop 2021 IR3.1 or 
later.

2.1.3 Interoperability with PolyWorks|ReportLoop for Excel (DataLoop) 

There is no interoperability constraint. 
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2021 IR4 or later
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2023 IR0 or later

2024 IR0 or later

2025 IR0 or later
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2.2 Server pre-installation checklist
The following items must be deployed prior to performing the steps detailed in Section 6. 
Installing the PolyWorks|DataLoop server applications. 

SQL Server

SQL Server 2017 or later, Standard or Enterprise edition, is installed

FILESTREAM storage is enabled in the SQL server (if used)

The Connection account and the Service account are configured

See Section 3. Setting up Microsoft SQL Server

Cloud file storage (if used)

The bucket or container is created

Access is configured in cloud services or the credentials are available

See Section 4.2 Cloud storage

Windows Server

The IT resource has the Administrator privileges on the application server

The IIS web server role must be installed on the application server

An HTML5 web browser must be installed

The Windows Server is added to the Windows domain to enable Windows users (if 
used)

See Section 5.1.1 Administrator privileges for application installation, Section 5.1.2 
Installing the IIS server role, and Section 5.1.3 Installing a supported web browser

SSL certificate

The DataLoop domain name (FQDN) has been defined

The DNS record is configured

A certificate in PFX format has been obtained

A certificate obtained from a well-known Certificate Authority (recommended).

See Section 5.1.4 Adding a record in your DNS for the PolyWorks|DataLoop domain 
name, Section 5.1.5 Obtaining an SSL certificate tied to the DataLoop domain name, 
and Section 5.1.6 Adding an HTTPS binding using an SSL certificate

Network

Ports requirements and firewall have been configured

See Section 5.2 Configuring port requirements
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2.3 Server requirements

2.3.1 Small team of up to 25 users (single machine)

If you expect that up to 25 users will use PolyWorks|DataLoop, you can install all server 
applications and the database server on a single machine that acts as a server:

Machine configuration

Operating system Microsoft Windows Server 2016, 2019, or 2022 only

CPU 4 cores

RAM 16 GB

Primary disk space
• 500 GB on a solid-state drive (SSD) for the operating 

system, all components to install, as well as for the 
Microsoft SQL Server instance and database files.1

1. The required size varies depending on the volume of data stored in the file 
system. A monitor software should be configured to send alerts when disk space 
is low.

Recommended cloud 
VM size

• Azure: B4ms: 4 Cores, 16 GB RAM
• AWS: t3.xlarge: 4 Cores, 16 GB RAM

File storage

• Microsoft Azure Blob Storage or Amazon S3 Storage 
(Recommended)

• FILESTREAM: At least 1 TB on a hard disk drive (HDD) for 
the Microsoft SQL Server FILESTREAM data1

Components to install

• Microsoft SQL Server 2017 or later
• Internet Information Services (IIS)
• SSL certificate - required for the HTTPS 

communication to the server2

• Chrome 64-bit web browser

2. SSL certificates issued from a well-known certification authority are 
recommended.
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2.3.2 Growing team of 25-50 users (single machine)

If you expect that up to 50 users will use PolyWorks|DataLoop, you can still install all server 
applications and the database server on a single machine that acts as a server but with 
increased capacity:

2.3.3 Large team of 50-250 users (two separate servers)

Machine configuration

Operating system Microsoft Windows Server 2016, 2019, or 2022 only

CPU 4 cores

RAM 32 GB

Primary disk space
• 500 GB on a solid-state drive (SSD) for the operating 

system, all components to install, as well as for the 
Microsoft SQL Server instance and database files.1

1. The required size varies depending on the volume of data stored in the file 
system. A monitor software should be configured to send alerts when disk space 
is low.

Recommended cloud 
VM size

• Azure: E4ads v5: 4 Cores, 32 GB RAM
• AWS: r5.xlarge: 4 Cores, 32 GB RAM

File storage

• Microsoft Azure Blob Storage or Amazon S3 Storage 
(Recommended)

• FILESTREAM: At least 4 TB on a hard disk drive (HDD) for 
the Microsoft SQL Server FILESTREAM data1

Components to install

• Microsoft SQL Server 2017 or later
• Internet Information Services (IIS)
• SSL certificate - required for the HTTPS 

communication to the server2

• Chrome 64-bit web browser

2. SSL certificates issued from a well-known certification authority are 
recommended.



PolyWorks|DataLoop - IT Administrator Guide 18

If you expect that 50 to 250 users will use PolyWorks|DataLoop, you must install server 
applications and the database server on two separate servers:

Server 1 configuration - Application Server

Operating 
system

Microsoft Windows Server 2016, 2019, or 2022 only

CPU 4 cores

RAM 16 GB

Primary disk 
space

• 250 GB on a solid-state drive (SSD) for the operating system and all the 
components to install

Recommended 
cloud VM size

• Azure: B4ms: 4 Cores, 16 GB RAM
• AWS: m5.xlarge: 4 Cores, 16 GB RAM

Components 
to install

• Internet Information Services (IIS)

• SSL certificate - required for the HTTPS communication to the server1

• Chrome 64-bit web browser

1. SSL certificates issued from a well-known certification authority are recommended. Note that 
the two servers must be on the same Windows domain for authentication using the Active 
Directory to work properly.

Server 2 configuration - Database Server

Operating 
system

Microsoft Windows Server 2012 R2 or later

CPU 4 cores

RAM 32 GB

Primary disk 
space

• 500 GB on a solid-state drive (SSD) for the operating system, all components 
to install, as well as for the Microsoft SQL Server instance and database files.

Recommended 
cloud VM size

• Azure: E4ads v5: 4 Cores, 32 GB RAM 
• AWS: r5.xlarge: 4 Cores, 32 GB RAM

File storage
• Microsoft Azure Blob Storage or Amazon S3 storage (recommended)
• FILESTREAM: At least 20 TB on a hard disk drive (HDD) for the Microsoft SQL 

Server FILESTREAM data.1

1. The required size varies depending on the volume of data stored in the file system. A monitor 
software should be configured to send alerts when disk space is low.

Components 
to install

• Microsoft SQL Server 2017 or later23

2. We recommend that you do not install Microsoft SQL Server on a domain controller (more 
information at https://docs.microsoft.com/en-us/sql/sql- server/install/hardware-and-
software-requirements-for-installing-sql-server?view=sql- server-2017#DC_support).

3. Microsoft SQL Server Enterprise Edition is recommended if 24/7 operation is required and no 
downtime is expected.
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2.4 Client requirements

2.4.1 PolyWorks|DataLoop Web Interface

Computers used to access the PolyWorks|DataLoop Web Interface must meet the following 
requirements:

2.4.2 PolyWorks|DataLoop Mobile Interface

Mobile devices used to access the mobile interface must meet the following requirements:

2.4.3 PolyWorks|ReportLoop for Excel (DataLoop)

Computers used to access the PolyWorks|ReportLoop for Excel (DataLoop) application must 
meet the following requirement:

2.5 Time synchronization
It is recommended to keep the time clocks of all computers that interact with the servers 
synchronized.

This can be achieved by synchronizing the clocks using NTP servers. Under Microsoft Windows, 
this can be automated across the domain by using the Windows Time service (W32Time).

Failure to keep the clocks synchronized might result in warnings in PolyWorks, as well as erratic 
behaviors during PolyWorks|DataLoop user authentication.

Supported operating 
systems 

Windows 64-bit

Supported web 
browsers

Chrome 64-bit web browser

RAM Minimum: 8GB

Graphics card Must be compatible with WebGL1

1. Some websites can be used to automatically verify if your graphics card is compatible 
with WebGL.

Apple® mobile devices iOS 16.0 or later

Compatible with iPhone

Android mobile devices Android version 13 or later

Microsoft Excel Microsoft 365 Desktop (version 2101 or later) or Microsoft 
Office Web Apps (with Microsoft Edge (Chromium) or 
Google Chrome browser)
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3. Setting up Microsoft SQL Server
Microsoft SQL Server must be installed and configured before setting up PolyWorks|DataLoop 
server. InnovMetric Software Inc. does not provide support with setting up Microsoft SQL 
Server.

For help on setting up Microsoft SQL Server, see the Microsoft website for SQL Server support.

3.1 Prerequisites
 Microsoft SQL Server 2017 or later, Standard or Enterprise edition. Microsoft SQL Server 

2017 is the minimum version that is compatible with PolyWorks|DataLoop. For information 
on the minimum requirements for Microsoft SQL Server itself, see the Microsoft website for 
SQL Server support.

 Microsoft SQL Server Management Studio (SSMS) installed on the server or elsewhere.
https://learn.microsoft.com/en-us/sql/ssms/sql-server-management-studio-ssms

 If you use SQL server logins, you must select the SQL Server and Windows Authentication 
mode option under server authentication, available on the Security page of the Microsoft 
SQL Server Properties. 

 If the server is a member of a domain, make sure it is not a domain controller to avoid 
potential issues. If the Microsoft SQL Server must be installed on a domain controller, you 
will need to install PolyWorks|DataLoop server applications on another non-domain 
controller server.

3.2 Activating the TCP/IP Protocol
Make sure that the TCP/IP Protocol is enabled in the Microsoft SQL Server Network 
Configuration. Follow the procedure available on the Microsoft website at:
https://learn.microsoft.com/en-us/sql/database-engine/configure-windows/enable-or-disable-
a-server-network-protocol

3.3 Configuring the SQL Server accounts
In order to setup PolyWorks|DataLoop, you will need two accounts on your SQL Server. You 
can use Windows or an SQL server login as an authentication method. 

1. SQL connection account: This account will be used when creating the database and 
configuring the service account inside PolyWorks|DataLoop Core Configurator.

1.1 The account must be a part of these server roles:

 db_creator

 securityadmin (or have the ALTER ANY LOGIN permission)

2. Service account: This account will be used during the execution of PolyWorks|DataLoop 
Core to execute SQL queries in the database.

https://learn.microsoft.com/en-us/sql/database-engine/configure-windows/enable-or-disable-a-server-network-protocol
https://learn.microsoft.com/en-us/sql/ssms/sql-server-management-studio-ssms
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2.1 For security reasons, we recommend using Windows authentication with a service 
account (i.e., an account that does not have password expiration and prohibits 
interactive logins in Windows). A domain user or a managed service account created 
by the IT administrator are recommended. 

2.2 The service account will be automatically added in the DataLoop database with the 
db_datareader and db_datawriter database roles.
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4. Setting up file storage
PolyWorks|DataLoop supports two types of file storage. The first one uses the FILESTREAM 
technology on the SQL server, while the other uses a cloud file storage. The supported cloud 
file storage options are Amazon S3 and Microsoft Azure Blob Storage.

4.1 Microsoft SQL Server FILESTREAM
FILESTREAM enables SQL Server-based applications to store data on the file system. It is not 
automatically enabled when you install or upgrade Microsoft SQL Server. To enable 
FILESTREAM, follow the procedure available on the Microsoft website at: 

https://learn.microsoft.com/en-us/sql/relational-databases/blob/enable-and-configure-
filestream

Note that on the FILESTREAM tab of the SQL Server (MSSQLSERVER) Properties dialog box, 
Enable FILESTREAM for Transact-SQL access must be selected. 

1. In SQL Server Management Studio, click New Query to display the Query Editor.

2. In Query Editor, enter the following Transact-SQL code:

EXEC sp_configure filestream_access_level, 1 
RECONFIGURE

3. Click Execute.

4. Restart the SQL Server service.

More information on FILESTREAM is available on the Microsoft website at:

https://learn.microsoft.com/en-us/sql/relational-databases/blob/filestream-sql-server

4.2 Cloud storage
The instructions below are indicative only. Please ensure that the configuration respects the IT 
security policies defined by your organization.

Be aware that the backup procedure must be adapted when using cloud storage, as the 
database backup will not include files. Verify with your cloud storage provider for instructions 
on how to obtain backups of files.

https://learn.microsoft.com/en-us/sql/relational-databases/blob/enable-and-configure-filestream
https://learn.microsoft.com/en-us/sql/relational-databases/blob/filestream-sql-server
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4.2.1 Amazon S3

Files stored in Amazon S3 use S3 Intelligent-Tiering. More information is available in the 
Amazon S3 documentation at: 
https://docs.aws.amazon.com/AmazonS3/latest/userguide/intelligent-tiering.html.

Note that the Archive Access tier and Deep Archive Access tier must not be enabled.

4.2.1.1 Bucket creation

To create the bucket, proceed as follows:

1. Open the S3 console (https://console.aws.amazon.com/s3/).

2. Click Create bucket.

3. Enter a bucket name.

4. Click Create bucket.

4.2.1.2 DataLoop bucket access

The bucket must be accessible from the PolyWorks|DataLoop server. The configuration 
depends on whether PolyWorks|DataLoop is installed within an Amazon EC2 instance or on 
premises.

4.2.1.3 Configuration for an Amazon EC2 instance

Create a policy

1. Open the IAM console (https://console.aws.amazon.com/iam).

2. Click Policies, then click Create policy.

3. Click JSON.

4. Paste the following text, replacing BUCKET_NAME with the name of the bucket created 
earlier.

               {

                    "Version": "2012-10-17",

                    "Statement": [

                        {

                            "Effect": "Allow",

https://docs.aws.amazon.com/AmazonS3/latest/userguide/intelligent-tiering.html
https://console.aws.amazon.com/s3/
https://console.aws.amazon.com/iam
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                            "Action": "s3:ListBucket",

                            "Resource": "arn:aws:s3:::BUCKET_NAME"

                        },

                        {

                            "Effect": "Allow",

                            "Action": [

                                "s3:PutObject",

                                "s3:GetObject",

                                "s3:DeleteObject"

                            ],

                            "Resource": "arn:aws:s3:::BUCKET_NAME/*"

                        }

                    ]

                }

5. Click Next.

6. Enter a name for the policy, such as S3ForDataLoop.

7. Click Create policy.

Create a role

1. Open the IAM console (https://console.aws.amazon.com/iam).

2. Click Roles, then click Create role.

3. Select EC2, then click Next.

4. Select the previously created policy, then click Next.

5. Enter a name for the role, such as DataLoopS3ForEC2.

Attach the IAM instance profile to the EC2 instance

1. Open the Amazon EC2 console (https://console.aws.amazon.com/ec2).

2. Click Instances.

3. Select the instance that you want to attach the IAM role to.

4. Click the Actions tab, click Security, then click Modify IAM role.

https://console.aws.amazon.com/iam
https://console.aws.amazon.com/ec2
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5. Select the IAM role that you just created, then click Save. The IAM role is assigned to your 
EC2 instance.

4.2.1.4 Configuration for an on-premises server

The goal of this procedure is to give the PolyWorks|DataLoop service account user access to 
the bucket.

This can be achieved using one of two methods: IAM Everywhere or standard access keys. IAM 
Everywhere is more secure, but more involved.

Note that the PolyWorks|DataLoop Core Configurator and PolyWorks|DataLoop IIS application 
pools (in the IIS Manager) must be restarted for the changes to take effect.

Using IAM Everywhere

To configure the bucket access using IAM Everywhere, use the following guides:

https://docs.aws.amazon.com/rolesanywhere/latest/userguide/introduction.html

https://aws.amazon.com/blogs/security/extend-aws-iam-roles-to-workloads-outside-of-aws-
with-iam-roles-anywhere/

The credentials file (~/.aws/credentials) must be copied to the following folders:

 The .aws folder of the user.

 With a Windows service account: C:\Users\USER_NAME\.aws (replace USER_NAME with the 
name of the service account without the domain).

 With a SQL Server login service account: C:\users\DataLoopCoreAPIAppPool\.aws.

Using access keys

1. Create a policy.

1.1 Open the IAM console (https://console.aws.amazon.com/iam).

1.2 Click Policies, then Create policy.

1.3 Click JSON.

1.4 Paste the following text and change BUCKET_NAME for the name the bucket created 
earlier.

               {

                    "Version": "2012-10-17",

                    "Statement": [

                        {

https://docs.aws.amazon.com/rolesanywhere/latest/userguide/introduction.html
https://aws.amazon.com/blogs/security/extend-aws-iam-roles-to-workloads-outside-of-aws-with-iam-roles-anywhere/
https://console.aws.amazon.com/iam.
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                            "Effect": "Allow",

                            "Action": "s3:ListBucket",

                            "Resource": "arn:aws:s3:::BUCKET_NAME"

                        },

                        {

                            "Effect": "Allow",

                            "Action": [

                                "s3:PutObject",

                                "s3:GetObject",

                                "s3:DeleteObject"

                            ],

                            "Resource": "arn:aws:s3:::BUCKET_NAME/*"

                        }

                    ]

                }

1.5 Click Next.

1.6 Enter a name for the policy, such as S3ForDataLoop.

1.7 Click Create policy.

2. Create a user.

2.1 Open the IAM console (https://console.aws.amazon.com/iam).

2.2 Click Users, then Add users.

2.3 Enter a name.

2.4 Click Attach policies directly.

2.5 Select the policy created earlier, then click Next.

2.6 Click Create user.

3. Create an access key for the user.

3.1 Click Security credentials.

3.2 Click Create access keys.

3.3 Click Application running outside AWS, then click Next.

3.4 Click Create access key.

https://console.aws.amazon.com/iam.
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4. Set up credentials.

4.1 Open a file browser in the Scripts folder inside the DataLoop Core installation folder.

4.2 Right-click on the SetupFileStorageCredentialsForOnPremisesServer-Amazon.cmd file and 
select Run as administrator.

4.3 Enter the requested information.

4.4 If PolyWorks|DataLoop Core Configurator is currently running on the server, you will 
have to manually restart it for the changes to take effect.

4.2.2 Microsoft Azure Blob Storage

To use Microsoft Azure Blob Storage, you must have a storage account and a container. Azure 
must also be correctly configured to allow PolyWorks|DataLoop to access the container.

4.2.2.1 Storage account creation

You must have a storage account to store PolyWorks|DataLoop files in Azure Blob Storage. You 
can use an existing storage account or create a new one by following the instructions in this 
guide: https://learn.microsoft.com/en-us/azure/storage/common/storage-account-create.

4.2.2.2 Container creation

A new container must be created to store PolyWorks|DataLoop file data in Microsoft Azure 
Blob Storage. You can create the new container by following the instructions in this guide: 
https://learn.microsoft.com/en-us/azure/storage/blobs/blob-containers-portal.

4.2.2.3 Custom role creation

1. In your resource group Access control (IAM), click Add and then click Add custom role. If 
you cannot find the Add custom role option, follow the instructions in this guide: 
https://learn.microsoft.com/en-us/azure/role-based-access-control/custom-roles-
portal#start-from-scratch.

2. On the Basics tab: 

2.1 Specify a name for the custom role in the Custom role name text box. 

2.2 From the Baseline permissions, select Start from scratch. 

3. Click the Permissions tab and click Add Permission. 

4. Navigate to the Add Permissions page and choose Microsoft Storage from the resource 
provider list. 

5. On the Microsoft.Storage page:

https://learn.microsoft.com/en-us/azure/storage/common/storage-account-create
https://learn.microsoft.com/en-us/azure/storage/common/storage-account-create
https://learn.microsoft.com/en-us/azure/storage/common/storage-account-create
https://learn.microsoft.com/en-us/azure/storage/blobs/blob-containers-portal
https://learn.microsoft.com/en-us/azure/role-based-access-control/custom-roles-portal#start-from-scratch
https://learn.microsoft.com/en-us/azure/role-based-access-control/custom-roles-portal#start-from-scratch
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5.1 Select the Data Actions radio button at the top of the page to show only the 
permissions that apply to Data Actions. 

5.2 Choose the permissions Read Blob, Write Blob, and Delete Blob, then click Add. 

6. Click Review + create to create the new custom roles. 

4.2.2.4 PolyWorks|DataLoop container access

The container must be accessible from the PolyWorks|DataLoop server. The configuration 
depends on whether PolyWorks|DataLoop is installed within an Azure-hosted virtual machine 
or on premises. 

Configuration for an Azure-host virtual machine

You can follow steps 1 and 2 of this guide: https://learn.microsoft.com/en-
us/dotnet/azure/sdk/authentication/azure-hosted-apps.

Please note that step 2 requires you to select the following values for the role and members 
when creating the role assignment:

 Role: The custom role created previously in the Custom role creation section.

 Members: The application service principal created in step 1.

Configuration for an on-premises server

You must start by creating the credentials that will be used by the PolyWorks|DataLoop server 
applications to connect to the Microsoft Azure Blob Service. Please follow steps 1 and 2 of this 
guide: https://learn.microsoft.com/en-us/dotnet/azure/sdk/authentication/on-premises-apps.

Please note that step 2 requires you to select the following values for the role and members 
when creating the role assignment:

 Role: The custom role created previously in the Custom role creation section.

 Members: The application service principal created in step 1.

Finally, you must set up the credentials on the PolyWorks|DataLoop server to connect to your 
container.

1. Open your file browser in the Scripts folder inside the DataLoop Core installation folder.

2. Right-click on the SetupFileStorageCredentialsForOnPremisesServer-Azure.cmd file and select 
Run as administrator. 

3. Enter the requested information.

4. If PolyWorks|DataLoop Core Configurator is currently running on the server, you will have 
to manually restart it for the changes to take effect. 

https://learn.microsoft.com/en-us/dotnet/azure/sdk/authentication/azure-hosted-apps
https://learn.microsoft.com/en-us/dotnet/azure/sdk/authentication/on-premises-apps
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5. Setting up the PolyWorks|DataLoop 
application server and security

5.1 IT prerequisites

5.1.1 Administrator privileges for application installation

To be able to install the PolyWorks server applications, the IT resource needs Administrator 
privileges on the PolyWorks|DataLoop application server.

5.1.2 Installing the IIS server role

The IIS web server role must be installed on the application server. An IIS website named 
“Default Web Site” must also be present on the server.

Note that the web server should only be used for PolyWorks|DataLoop server applications.

5.1.3 Installing a supported web browser 

An HTML5 web browser must be installed on the application server to run some PolyWorks 
server applications (e.g., Google Chrome). 

5.1.4 Adding a record in your DNS for the PolyWorks|DataLoop domain name 

To configure the secure communication, a PolyWorks|DataLoop domain name is required (i.e., 
Dataloop.CompanyName.com). 

A record must be added in the DNS to associate this PolyWorks|DataLoop domain name with 
an application server IP address. This record must be added in the correct host zone of the 
domain. 

5.1.5 Obtaining an SSL certificate tied to the DataLoop domain name 

The PolyWorks|DataLoop server architecture requires an SSL certificate to encrypt and secure 
the communication between client and server. An SSL certificate from a well-known certificate 
authority is recommended. 

If an SSL certificate for the PolyWorks|DataLoop domain name is not available, obtaining one is 
required. 

Internet Information Services (IIS) require the SSL certificate in the PFX format. If necessary, a 
PFX file can be created from the server certificate file and private key file used to generate the 
certificate. 
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The type of SSL certificate selected must comply with the security policies of your company. 

5.1.6 Adding an HTTPS binding using an SSL certificate

PolyWorks|DataLoop server applications connect using the standard HTTPS encrypted 
protocol. This protocol is used to manage transactions between applications. In order to enable 
using the HTTPS connections, an SSL certificate must be added. 

Proceed as follows:

1. Open the IIS Manager and navigate to Sites > Default Web Site. Then, click Bindings, located 
on the right panel.

2. In the Site Bindings window, click Add. 

Certificate from an 
external 
certificate 
authority 
(recommended)

This type of certificate is very secure and can be used on 
production servers and in setups where suppliers will connect to 
the OEM PolyWorks|DataLoop server. 

You can obtain a certificate for free from the Let’s Encrypt 
certificate authority. See https://letsencrypt.org/getting-started/ 
for more details.

Certificate from an 
internal certificate 
authority

This type of certificate is generated by your company. It is 
included in your private IT infrastructure.

If you need suppliers to connect to your PolyWorks|DataLoop 
server, the certificate might not be accepted by the supplier ITs. 

Self-signed 
certificate

Self-signed certificates should be used only for test or proof of 
concept servers where a small number of internal users will 
connect to PolyWorks|DataLoop.
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The Add Site Binding window is displayed.

3. Set the parameters as follows:

3.1 Set the Type to https.

3.2 Make sure that the IP address is set to All Unassigned.

3.3 Make sure that the Port is set to 443.

3.4 Make sure that the Host name value is equal to your PolyWorks|DataLoop domain 
name.

3.5 Make sure that the check boxes are cleared.

3.6 Select the SSL certificate to use. Note that, if your certificate is not shown in the list, 
you must import the certificate in the server certificate store to make it accessible to 
IIS. Follow the import procedure available on the Microsoft website here: 
https://learn.microsoft.com/en-us/troubleshoot/windows-server/windows-
security/install-imported-certificates

4. Click OK.

5. In the Site Bindings window, select the http binding and click Remove.

6. Close the Site Bindings window.

7. Restart the IIS server.

https://learn.microsoft.com/en-us/troubleshoot/windows-server/windows-security/install-imported-certificates


PolyWorks|DataLoop - IT Administrator Guide 32

5.2 Configuring port requirements
Some PolyWorks products require ports to communicate. These ports are listed in the table 
below:

Source Destination Port Notes

Metrology Suite

Web browser - DataLoop Web 
Interface

Web browser - DataLoop Core 
Administrator

DataLoop Web Interface Server

DataLoop Mobile Interface

DataLoop Core 443 TCP HTTPS

Web browser - DataLoop Web 
Interface

DataLoop Mobile Interface

DataLoop Web 
Interface Server 443 TCP HTTPS

DataLoop Core

DataLoop Web Interface Server

Web browser - Collaborative 
Suite License Server

Collaborative Suite 
License Server 443 TCP HTTPS

DataLoop Core

Microsoft SQL Server 1433 TCP SQL Server default 
port

Microsoft Active 
Directory

(For Active Directory 
users)

389 TCP+UDP LDAP default port 

88 TCP Kerberos default port

135 TCP Microsoft RPC 
Endpoint Mapper

Collaborative Suite License 
Server

InnovMetric 
Subscription Server 443 TCP

HTTPS

(An offline mode is also 
available)
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6. Installing the PolyWorks|DataLoop 
server applications
The required DataLoop server installer is available on MyPolyWorks via the InnovMetric 
website. To obtain the installer, go to Software Downloads > Data Management & Digital 
Connectivity, select the PolyWorks|DataLoop 2025 Setup Package, and download the desired 
release. The downloaded package contains the DataLoop server installer.

To ensure that the applications are installed on the appropriate machine, see Section 2.3 Server 
requirements. 

6.1 Launch the DataLoop server installer
To install the DataLoop server applications as listed in Section 1.2 Server applications and 
required prerequisites, proceed as follows:

1. Launch the DataLoop server installer executable file (.exe). 

2. Click View license terms to open and read the license agreement in a separate window.

3. Specify the installation folder. 

4. Click Agree and install to continue.

A window is displayed to show the progress of the installation.

As a result of the installation:

 The DataLoop server applications will be installed under the specified folder.

 The required IIS application pools and web applications are created under “Default Web 
Site”.

 The PolyWorks|DataLoop Core Configurator is opened.

6.2 Setting up PolyWorks|DataLoop Core

6.2.1 Configuring the essential PolyWorks|DataLoop Core Configurator 
parameters

1. A connection to Microsoft SQL server must be established. See Section 8.1 Connect to 
Microsoft SQL server in PolyWorks|DataLoop Core Configurator.

2. A database must be created. See Section 8.2 Create a database.

3. The service account, which connects to a database to execute SQL queries, must be 
configured. See Section 8.3 Configure the service account.

4. The fully qualified domain name (FQDN) of the PolyWorks|DataLoop server and the 
PolyWorks Collaborative Suite License Server host must be configured. See Section 8.4 
Configure the server FQDN and the PolyWorks Collaborative Suite License Server host.
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6.3 Setting up PolyWorks Collaborative Suite License Server

6.3.1 Registering the license server online 

Once the Collaborative Suite License Server application is installed, it must be registered. The 
registration operation is used to identify the computer used to host the license server as well 
as obtain licenses. Once the license server is registered, the license server unique ID can only 
be used from that computer.

Before registering the license server, make sure that an internet connection is available.

To register the license server, proceed as follows:

1. Open the Collaborative Suite License Server application in your web browser.

2. On the left menu, click Registration to open the License server registration page.

3. Type in the license server unique ID that you received by email.

If you did not receive one, contact your PolyWorks provider.

4. Click Register.

A green icon and a message are displayed in the License server registration page to 
indicate that the license server has been registered successfully.

If the registration fails, a red icon is displayed in the License server registration page. In 
this case, make sure that you are connected to the internet and that you typed the unique 
ID properly (it is case sensitive and consists of 16 alphanumerical characters). If it still does 
not work, contact your PolyWorks provider.
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When the registration is successful, you are automatically directed to the Licensing 
information page.

Note that the license server can also be registered offline. For more information, see the 
installation guide (.pdf) that is provided with the installation file (.msi) of the PolyWorks 
Collaborative Suite License Server application.

6.4 Setting up PolyWorks|DataLoop Web Interface Server 
(optional)

6.4.1 Changing the default language (optional)

To change the language used in PolyWorks|DataLoop Web Interface: 

1. Open a file browser in the “rest” folder which can be found inside the PolyWorks|DataLoop 
Web Interface Server installation folder. 

2. Open the “appsettings.json” file in a text editor.

3. In the AppSettings section, set the Language parameter to the desired value and save the 
file. Here is the list of all supported languages, the default one is English-EN:  

German DE

Japanese JA

Chinese Traditional ZH-rTW

Chinese Simplified ZH-rCN

Korean KO

Czech CS
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4. Restart the IIS server by calling the iisreset command in a Windows command prompt.

6.4.2 Adding global shortcuts (optional)

Global shortcuts that are visible to all users can be added to the PolyWorks|DataLoop Web 
Interface home page. 

To create global shortcuts:

1. Open a file browser in the “rest” folder which can be found inside the PolyWorks|DataLoop 
Web Interface Server installation folder. 

2. Open the “GlobalShortcutSettings.json” file in a text editor.

3. Add global shortcut info, as in the example shown below.

[

{

"DisplayName": "Google",

"Link":"https://www.google.com"

},

{

"DisplayName": "Microsoft 365",

"Link":"https://www.office.com"

}

]

When the configuration is detected by PolyWorks|DataLoop Web Interface, the shortcut is 
added as a global shortcut.

English EN

French FR

Hungarian HU

Italian IT

Polish PL

Portuguese PT

Russian RU

Spanish ES
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7. Connecting an external identity provider 
to PolyWorks|DataLoop
In this section, you will find the steps to connect your organization’s identity provider to 
PolyWorks|DataLoop.

7.1 SAML 2.0 identity provider

7.1.1 Prerequisites

 You must have an identity provider available in your organization that supports the SAML 
2.0 protocol. 

 Users and groups that need access to PolyWorks|DataLoop must already be present in the 
identity provider.

 Only the web browser SSO profile using SP-initiated flow is supported. 

7.1.2 Setting up the SAML 2.0 service provider in your identity provider for the 
PolyWorks|DataLoop server

To connect your identity provider to PolyWorks|DataLoop, you will need to create a SAML 
service provider configuration in your identity provider. The steps for setting these SAML 
configurations will differ depending on your identity provider.

7.1.2.1 Custom identity provider

SAML 2.0 configuration

1. Import the PolyWorks|DataLoop service provider metadata file in your identity provider. 
The metadata and the metadata location URL can be found in the Identity providers tab of 
the PolyWorks|DataLoop Core Configurator.

If your identity provider does not support the automatic update of the service provider 
metadata file using the metadata location URL, the PolyWorks|DataLoop metadata file 
must be updated every year manually. 

2. Set the callback URL (or reply URL) in your SAML 2.0 configuration to this value: 
https://[DATALOOP_SERVER_FQDN]/dataloopcore/identity/Saml2/Acs, where 
[DATALOOP_SERVER_FQDN] represents the fully qualified domain name of your 
PolyWorks|DataLoop server. 
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3. Validate that the following values are set in your SAML configuration, replacing 
[DATALOOP_SERVER_FQDN] by the fully qualified domain name of your 
PolyWorks|DataLoop server. 

Mapping the user claims

Claims mapping is necessary to access user properties from PolyWorks|DataLoop. You will 
need to add the following claims to your SAML configuration:

Manage user groups from the identity provider (recommended)

PolyWorks|DataLoop user groups can be managed from your identity provider. We 
recommend doing so, since it removes the need to add users individually in 
PolyWorks|DataLoop.

To use SAML groups in PolyWorks|DataLoop, you must first add a group claim in your SAML 
configuration. Note that groups can also be referred to as roles.

SAML configuration 
name Value

Identifier (Entity ID) https://[DATALOOP_SERVER_FQDN]/dataloopcore/identity

Reply URL (or Callback 
URL)

https://[DATALOOP_SERVER_FQDN]/dataloopcore/identity/Saml2/Acs

Sign on URL (or Login 
URL)

https://[DATALOOP_SERVER_FQDN]/dataloopcore/identity/Account/Logi
n 

Logout URL (optional) https://[DATALOOP_SERVER_FQDN]/dataloopcore/identity/Saml2/Logou
t

PolyWorks|DataLoop 
claim type Value Requirement

urn:sub The unique identifier of the user. Usually, it 
is a UUID.

Mandatory

urn:uniquename The human-readable, unique name of the 
user. It can be an email or username.

Mandatory

urn:displayname The name displayed for the user in 
PolyWorks|DataLoop user interfaces. 

Recommended

urn:email The email address to use to send email 
notifications to the user.

Recommended

PolyWorks|DataLoop 
claims type Value description

urn:groups List of human-readable, unique group names
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Request signature validation (optional)

If your organization’s security practices require the validation of all SAML requests made to 
your identity provider, you must add the PolyWorks|DataLoop service provider certificate in 
the configuration section of your identity provider. You can download the PolyWorks|DataLoop 
service provider certificate from the Identity providers tab in the PolyWorks|DataLoop Core 
Configurator. Keep in mind that the certificate is also included in the PolyWorks|DataLoop 
service provider metadata file.

Adding the identity provider in PolyWorks|DataLoop Core Configurator

To add your identity provider to PolyWorks|DataLoop, open PolyWorks|DataLoop Core 
Configurator and follow the procedure outlined in Section 8.8.1 Adding an SAML 2.0 identity 
provider to PolyWorks|DataLoop.

Adding users and groups in PolyWorks|DataLoop Core Administrator

To grant access to PolyWorks|DataLoop to your identity providers groups and users (if 
necessary), you must add them manually in PolyWorks|DataLoop Core Administrator. For 
more information, refer to the PolyWorks|DataLoop Core Administrator User Guide.

7.1.2.2 Azure AD

This is an overview of the procedure that allows the Azure Active Directory (AD) identity 
provider to connect to PolyWorks|DataLoop using the SAML protocol 2.0.

Adding Azure AD SAML Toolkit to the enterprise application

Once signed in to the Azure Portal using an admin user, proceed as follows:

1. On the left navigation pane, select the Azure Active Directory service.

1.1 Navigate to Enterprise applications.

1.2 Click All applications. 

1.3 Click New application to add a new application.

2. On the Browse Azure AD Gallery page: 



PolyWorks|DataLoop - IT Administrator Guide 40

2.1 Type Azure AD SAML Toolkit in the search box.

2.2 Select Azure AD SAML Toolkit from the results panel, then add the app. Wait a few 
seconds while the app is added to your tenant.

3. On the next window:

3.1 Type a representative name in Name, for example DataLoop_AZURE_AD as shown in 
the image below.

3.2 Click Create.
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Configuring the SAML toolkit for DataLoop Server

To configure Azure AD SSO with Azure AD SAML Toolkit, perform the following steps:

Configuring users and groups

1. Configure Azure AD SSO to assign users to use this feature by clicking Assign users and 
groups.

2. To add users to the Azure AD Enterprise application, click Add user/group.
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3. Click None selected to gain access to the Users and groups section. Search for the user to 
add and click it. Repeat the process for each user or group. When all desired users and 
groups have been added, click Select.

4. Click Assign on the window that is displayed to complete the process.

Those steps can be repeated as needed to add more users and groups. 

Note the following:

 Clicking Users and groups on the left action pane displays the users and/or groups already 
added and assigned to the enterprise application.
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 For groups, only Azure AD security groups should be used.

 Users and groups need to be added to the Enterprise Application in Azure AD to be granted 
access to DataLoop. The users and/or groups that need access to DataLoop must also be 
added on the User Management page of the DataLoop Core Administrator. For more 
information, refer to the PolyWorks|DataLoop Core Administrator User Guide.

Configuring the SAML Single Sign-On

1. Click Single sign-on, then click SAML to begin the configuration.

2. Click Edit in the Basic SAML Configuration section.

3. Configure the SAML URLs as follows:
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3.1 Type the URLs as shown below, replacing DATALOOP_SERVER_FQDN by the fully 
qualified domain name of the DataLoop Server.

3.2 Click Save to save the changes made to the URLs.

Note the following:

 The URLs are case sensitive.

 The Relay State URL is not configured, as it is optional.

4. Add the claims into Attributes & Claims.
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4.1 Click Edit, in the Attributes & Claims section, as shown:

4.2 Click Add new claim.

4.3 Type urn:uniquename in Name. Namespace can be left blank. For the Source 
attribute, select user.userprincipalname. Click Save.
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4.4 Repeat the two previous steps to add three more claims with the following name and 
source attribute: urn:displayname/user.displayname, urn:email/user.mail, and 
urn:sub/user.objectid. The claims should then appear as shown.

4.5 To add the group claim to manage DataLoop users by group, click Add a group claim.

4.6 Fill the Group Claims section on the right as follows:

 For the groups associated with the user, select Groups assigned to the application. 

 For Source attribute, choose Cloud-only group display names (Preview).

 Select Customize the name of the group claim.

 Type urn:groups in Name.
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 Click Save.



PolyWorks|DataLoop - IT Administrator Guide 48

The group claim is added to the list.

Adding the identity provider in PolyWorks|DataLoop Core Configurator

To add your identity provider to PolyWorks|DataLoop, open PolyWorks|DataLoop Core 
Configurator and follow the procedure outlined in Section 8.8.1 Adding an SAML 2.0 identity 
provider to PolyWorks|DataLoop.

Adding users and groups in PolyWorks|DataLoop Core Administrator

To grant access to PolyWorks|DataLoop to your identity providers groups and users (if 
necessary), you must add them manually in PolyWorks|DataLoop Core Administrator. For 
more information, refer to the PolyWorks|DataLoop Core Administrator User Guide.
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7.2 Windows Active Directory
This identity provider collects users and groups from the Windows Active Directory located 
inside the Windows Domain joined by the PolyWorks|DataLoop server. 

7.2.1 Prerequisites

 The Active Directory must be located in one of the following:

 The same Windows Domain as the PolyWorks|DataLoop server.

 A trusted domain inside your organization (see Section 7.2.3 Trust relationship between 
domains (optional) for more information).

 Users and groups that need access to PolyWorks|DataLoop must already be present in the 
Windows Active Directory.

7.2.2 Manage user groups from Windows Active Directory (recommended)

Managing PolyWorks|DataLoop user groups using Windows Active Directory is recommended, 
since it removes the need to add users individually in PolyWorks|DataLoop.

To be added, the Windows Active Directory group type must be Security.

7.2.3 Trust relationship between domains (optional)

We support users provisioned from trusted domains inside your organization. To use these 
features, you must add the trust relationship between the PolyWorks|DataLoop server domain 
and the targeted trusted domain.

7.2.4 Hardened Active Directory configuration (optional)

The built-in group Pre-Windows 2000 Compatible Access must be enabled. In order for the 
PolyWorks|DataLoop server to be able to validate users and groups from the Active Directory, 
at least one of the following must be a member of that group:

 The computer object of the server where the PolyWorks|DataLoop server applications are 
installed.

 The Windows service account configured in PolyWorks|DataLoop Core Configurator that is 
used to execute the IIS application pools.

7.2.5 Adding users and groups in PolyWorks|DataLoop Core Administrator

To grant access to PolyWorks|DataLoop to your identity providers groups and users (if 
necessary), you must add them manually in PolyWorks|DataLoop Core Administrator. For 
more information, refer to the PolyWorks|DataLoop Core Administrator User Guide.
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8. The PolyWorks|DataLoop Core 
Configurator
After the installation process is complete, the PolyWorks|DataLoop Core Configurator is 
launched. It allows creating databases and configuring parameters needed to use 
PolyWorks|DataLoop, as well as review information and test part of the system. Note that the 
PolyWorks|DataLoop system cannot be used until its essential parameters have been 
configured.

8.1 Connect to Microsoft SQL server in PolyWorks|DataLoop 
Core Configurator
Connection to the Microsoft SQL server is required for most operations in the 
PolyWorks|DataLoop Configurator. To connect: 

1. Click SQL Server connection at the bottom of the PolyWorks|DataLoop Core Configurator.

The Connect to Microsoft SQL Server dialog box is displayed. 
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2. Select the type of authentication information to use from the following: Windows 
authentication or SQL server login.

3. Type in the username or login in the corresponding text box. When using Windows 
authentication, the current Windows user is entered by default. Note that the user must 
have elevated permissions to use some of the features of the PolyWorks|DataLoop Core 
Configurator.

4. If using Microsoft SQL server login credentials, type in the password in the corresponding 
text box. Note that the Show button next to it allows displaying the characters of the 
password.

5. Click Connect. If the connection is successful, the dialog box closes.

Note that the dialog box is also displayed automatically when attempting to perform an 
operation that requires a connection to the Microsoft SQL server without being connected.

8.2 Create a database
The SQL account used for the SQL connection must meet the requirements detailed in Section 
3.3 Configuring the SQL Server accounts.

Databases can be created in PolyWorks|DataLoop Core Configurator. When there is no existing 
database, proceed as follows: 
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1. In the Storage page, click Create database. The Create database dialog box is displayed.

2. Type in the name of the new database in Database name.

3. Type in the password of the administrator user that will be created with the database. The 
password must be at least 8 characters long. Note that the Show button to its right allows 
displaying the characters of the password.

4. Select the type of file storage to use in Type. Choose from SQL Server FILESTREAM, 
Amazon S3, and Microsoft Azure Blob Storage. If Amazon S3 is selected, specify the 
bucket name in Bucket. If Microsoft Azure Blob Storage is selected, specify the storage 
account name in Storage Account, and specify the container name in Container. 

5. Specify the locations where the database files will be saved on the server, according to the 
type of file storage selected. 

When using SQL Server FILESTREAM:

 Specify the path to the folder in which the rows files (.mdf) of the database will be saved 
on the server in Rows data. The default value is the value of the SQL Server instance 
default data path of the Microsoft SQL Server.

 Specify the path to the folder in which the log files (.ldf) of the database will be saved on 
the server in Logs. The default value is the value of the SQL Server instance default 
data path of the Microsoft SQL Server.

 Specify the path to the folder in which the FILESTREAM files that correspond to the files 
stored in the database will be saved on the server in FILESTREAM data. If left empty, the 
SQL Server instance default data path will be used. For better performance, the disk 



PolyWorks|DataLoop - IT Administrator Guide 53

where this data is saved should be different from the one where the operating system 
or Microsoft SQL Server is installed.

When using cloud file storage:

 Specify the path to the folder in which the rows files (.mdf) of the database will be saved 
on the server in Rows data. The default value is the value of the SQL Server instance 
default data path of the Microsoft SQL Server.

 Specify the path to the folder in which the log files (.ldf) of the database will be saved on 
the server in Logs. The default value is the value of the SQL Server instance default 
data path of the Microsoft SQL Server.

Note that, after the database is created, changing these locations is extremely difficult.

6. Click Create database to create the database. The dialog boxes close and the newly created 
database is automatically selected in the PolyWorks|DataLoop Core Configurator. Click 
Apply to save the configuration.

Note that, by default, the database is in simple recovery model mode.
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8.3 Configure the service account
The service account, which connects to a database to execute SQL queries, can be configured 
on the Storage page of the System parameters tab. Note that the corresponding Host and 
Database name must already be specified.

The SQL account used for the SQL connection must meet the requirements detailed in Section 
3.3 Configuring the SQL Server accounts.

1. Select the type of authentication to use for the service account from the following: 
Windows account or SQL Server login. We recommend using Windows Authentication, as 
explained in Section 3.3 Configuring the SQL Server accounts. 

 If Windows authentication is selected, the Windows account running the 
PolyWorks|DataLoop Core IIS application pools is used to connect to the database. This 
account is also configured as the identity of the application pools of the DataLoop Core 
web applications.

 If SQL Server login is selected, the login name and the password of the account must 
also be typed in the corresponding text boxes. When this type of service account is used, 
the identity of the DataLoop Core IIS application pools is set to a built-in account. 

2. Once all the parameters are entered, click Test parameters. If everything is working 
correctly, Successful is displayed next to it. If there is an issue, an error message is 
displayed.

3. Click Apply to add the service account as a database user with db_datareader and 
db_datawriter database roles. 
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8.4 Configure the server FQDN and the PolyWorks 
Collaborative Suite License Server host
The PolyWorks|DataLoop server fully qualified domain name (FQDN) and the PolyWorks 
Collaborative Suite License Server host can be managed from the Services page of the System 
parameters tab.

A port number can be specified after the fully qualified domain name, preceded by a colon (i.e., 
name:997). The PolyWorks|DataLoop application URLs displayed on the page are automatically 
generated using the fully qualified domain name value. Note that any of the application URLs 
can be copied by clicking the adjacent button.

The following application URLs are displayed:

 Administrator - Displays the URL of the PolyWorks|DataLoop Core Administrator 
website. Browse opens the PolyWorks|DataLoop Core Administrator website in the 
default browser.

 API - Displays the URL of the PolyWorks|DataLoop Core API. 

 Web Interface - Displays the URL of the PolyWorks|DataLoop Web Interface website. 
Click Browse to open the PolyWorks|DataLoop Web Interface website in the default 
browser.

The host of the PolyWorks Collaborative Suite License server that validates access to 
PolyWorks|DataLoop users can be typed in Host. The default value for the host is the Fully 
qualified domain name of the PolyWorks|DataLoop server and can be edited, if needed. 

Click Test parameters to test if all services are online. If a service does not respond, the test 
immediately ends and an error message is displayed. An icon will appear next to Test 
parameters indicating the success or failure of the test.

Click Apply to save any changes made to the URLs.
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8.5 Obtain the XML manifest to deploy PolyWorks|ReportLoop 
for Excel
A file required for the deployment of the PolyWorks|ReportLoop for Excel add-in can be 
downloaded from the PolyWorks|ReportLoop for Excel page of the System parameters tab.

For more information, see 9.4.1 Deploying the add-in in the Microsoft 365 admin center.
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8.6 Configure the PolyWorks|DataLoop PLM Connector
The parameters needed for PolyWorks products to communicate with a PLM can be specified 
on the PolyWorks|DataLoop PLM Connector page of the System parameters tab.

1. Specify the system to use in the System list. The following values are offered: Teamcenter 
and Windchill. If no value has previously been selected, Teamcenter is the default value.

2. Specify the API URL of the PLM in Server URL.

3. Specify the path to the file containing the description of the data structure of the PLM in 
Configuration file. The Browse button next to it opens a file browser that allows browsing 
for the file path.

4. Click Apply to save the changes.
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8.7 Configure the outgoing email server
The parameters needed to configure the outgoing email server can be specified on the 
Outgoing email server page of the System parameters tab.

1. Type in the host of the SMTP server in Host.

2. Select the encryption used by the SMTP server in Encryption. Choose from None, TLS or 
STARTTLS. When an encryption method is selected, the port the most likely to be used is 
automatically displayed in Port. The port can also be manually edited if needed.

3. Type in the email address from which to send the emails from the DataLoop server in From 
address. Note that there is no warning if the email address is invalid.

4. Select the authentication method to use to connect to the SMTP server. Choose from User 
credentials or None. If User credentials is selected, type in the Username and Password 
to use for the authentication in the appropriate text boxes. Note that the Show button next 
to the Password text box is used to display the characters of the password.

5. Click Test parameters to test the parameters configured for the SMTP server. If there is an 
issue with the configuration, an error message is displayed. Note that no email is sent 
during this test.

6. Click Apply.

Note that the Configure and test email notifications link offers a shortcut to the Emails 
notifications page of the Options tab. For more information, see Section 8.13 Configuring the 
email notifications.
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8.8 Managing identity providers
Identity providers can be connected to PolyWorks|DataLoop to help manage users. They can 
be managed from the Identity providers tab of the PolyWorks|DataLoop Core Configurator.

PolyWorks|DataLoop currently supports the following identity provider types:

 SAML 2.0: Provisions users and groups from a SAML 2.0 compatible identity provider.

 Windows Active Directory: Provisions users and groups from a Windows Active Directory.

 PolyWorks|DataLoop built-in authentication: Stores users and group inside the 
PolyWorks|DataLoop database. This identity provider is used during the initial 
configuration of the PolyWorks|DataLoop server and is active by default in any new 
installation of PolyWorks|DataLoop.

The Identity providers tab contains the following:

 A table to display and edit the list of currently configured identity providers as well as 
indicate their active status and the protocol they use.

 A button that can be used to add a new identity provider to PolyWorks|DataLoop. 

 An hyperlink to the PolyWorks|DataLoop login page to test that the parameters 
configured for the identity providers function correctly.

 Information on the SAML 2.0 PolyWorks|DataLoop service provider that can be required 
to configure SAML 2.0 identity providers to function with PolyWorks|DataLoop. The 
Entity ID, Metadata location, and Certificate are available and can be copied and/or 
downloaded from this section.
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8.8.1 Adding an SAML 2.0 identity provider to PolyWorks|DataLoop

To add an identity provider to PolyWorks|DataLoop, proceed as follows. Note that the identity 
provider must already have been configured. For more information, see Section 7.1 SAML 2.0 
identity provider.

1. Click Add provider.

2. In the dialog box that is displayed, enter the following required information from the 
identity provider:

 Name: The display name to show on the PolyWorks|DataLoop login page for this identity 
provider.

 Base URL: The base URL of your identity provider vendor.

 Entity ID: The unique identifier of your identity provider. 
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 Metadata location: The location of the metadata of your identity provider. Specify either 
the path to the metadata file on the local computer or the URL that allows downloading the 
metadata file.

3. Click Add provider. The identity provider is displayed in the Identity providers table. Users 
and groups can now be added manually to PolyWorks|DataLoop from the identity provider 
using the PolyWorks|DataLoop Core Administrator.
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8.8.1.1 Finding the required information in Azure Active Directory

Display the Single sign-on page of the Azure Portal. The base URL (3), entity ID (4), and 
metadata location (2) are identified on the snapshot below.

8.8.2 Editing an identity provider in PolyWorks|DataLoop

To edit an identity provider that has already been added to PolyWorks|DataLoop, click the edit 
icon in the Action column of the desired identity provider.

For each identity providers, different parameters are available to the user. These parameters 
are explained in the sections that follow.
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8.8.2.1 PolyWorks|DataLoop built-in authentication

For the PolyWorks|DataLoop built-in authentication identity provider, the following 
parameters can be edited:

 Name: The name displayed in the PolyWorks|DataLoop login page for the identity provider. 

 Active: A check box that enables or disables the use of the identity provider in 
PolyWorks|DataLoop.

 Complexity requirements for new passwords: A section that allows setting up 
requirements for any new passwords of users in the identity provider. The minimum length 
of new passwords as well as the required character types can be specified.

 User account settings: A section that allows configuring whether users can change their 
own passwords for this identity provider. When selected, users can change their passwords 
from the Change Password page on the PolyWorks|DataLoop Account website.
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8.8.2.2 Windows Active Directory

For the Windows Active Directory identity provider, the following parameters can be edited:

 Name: The name displayed in the PolyWorks|DataLoop login page for the identity provider. 

 Active: A check box that enables or disables the use of the identity provider in 
PolyWorks|DataLoop.

Note that the users and groups from the identity provider that need access to 
PolyWorks|DataLoop must also be added manually on the User Management page of the 
PolyWorks|DataLoop Core Administrator. For more information, refer to the 
PolyWorks|DataLoop Core Administrator User Guide.

8.8.2.3 SAML 2.0

For an SAML 2.0 identity provider, the following parameters can be edited:

 Name: The name displayed in the PolyWorks|DataLoop login page for the identity provider. 

 Active: A check box that enables or disables the use of the identity provider in 
PolyWorks|DataLoop.
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 Base URL: The base URL of your identity provider vendor.

 Entity ID: The unique identifier of your identity provider. 

 Metadata location: The location of the metadata of your identity provider. It can be either 
a path to the metadata file on the local computer or the URL that allows downloading the 
metadata file.

Note that the users and groups from the identity provider that need access to 
PolyWorks|DataLoop must also be added manually on the User Management page of the 
PolyWorks|DataLoop Core Administrator. For more information, refer to the 
PolyWorks|DataLoop Core Administrator User Guide.

8.8.3 Deleting an SAML 2.0 identity provider from PolyWorks|DataLoop

To delete an SAML 2.0 identity provider from PolyWorks|DataLoop, proceed as follow:

1. Click the delete icon in the Action column of the desired identity provider.

2. A confirmation message is displayed. Click Delete provider to confirm the operation. The 
identity provider is deleted and removed from the Identity providers table.

Note that, when an identity provider is deleted, its users that were added to 
PolyWorks|DataLoop still exist, but are no longer able to connect to PolyWorks|DataLoop.
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8.9 Configuring the version history
The version history can be configured in the Version history page of the PolyWorks data tab. 
Deleting outdated data frees up storage space and helps improve performance. The section 
contains the following elements:

 Version history allows selecting how historical versions should be managed. Choose from:

 Automatically delete historical versions after a number of days - Historical versions 
are automatically deleted after the number of days specified in the adjacent text box.

 Keep all historical versions indefinitely - Historical versions are kept indefinitely.

 Apply allows saving changes made to the version history.

Note that, if the database is in full recovery model, a warning is displayed.
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8.10 Permanently deleting workspaces
Workspaces can be deleted in PolyWorks Workspace Manager, but some data is kept for a 
certain time to make it possible to recover a version of the deleted workspace, if needed. To 
free up space, it is possible for the administrator to permanently delete a workspace in the 
PolyWorks|DataLoop Core Configurator. Since permanently deleting workspaces can be a long 
process and the database cannot be used in the meantime, it is recommended to delete 
workspaces in the PolyWorks Metrology Suite and configure the version history behavior. 

To permanently delete a workspace in the PolyWorks|DataLoop Core Configurator, proceed as 
follows:

1. In the Workspace deletion page of the PolyWorks data tab, select the names of the 
workspaces to permanently delete in the Workspaces table.

2. When all desired workspaces are selected, click Permanently delete workspaces, then 
click Yes on the confirmation dialog box displayed. Note that the database will be taken 
offline while the workspaces are being deleted.
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8.11 Changing the password of the PolyWorks|DataLoop 
administrator account
The password of the PolyWorks|DataLoop administrator account can be edited in the 
Administrator account page of the Options tab.

1. Click Change password. The Change password dialog box is displayed.

2. Type in the new password in New password. It must be at least 8 characters long. Note that 
the Show button next to it allows displaying the characters of the password.

3. Click Change password.
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8.12 Adding announcements for users
Announcements can be added by the administrator in the Announcement page of the Options 
tab. The announcement is shown to users when they log in using web browsers. This can be 
used, for example, to warn users of planned maintenance periods.

To add an announcement, proceed as follows:

1. Select Active to display the announcement as soon as the changes are applied.

2. Type in the Title and the Content of the message to communicate to the users.

3. Click Apply.
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4. To ensure the announcement is displayed correctly, click the test link at the bottom of the 
page to display a PolyWorks|DataLoop login page. The announcement is displayed, as 
shown in the example.

Note that it is recommended to activate the announcement at least a few days in advance to 
ensure users will see it.
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8.13 Configuring the email notifications
The parameters of the email notifications can be configured on the Email notifications page of 
the Options tab.

1. In the Technical contacts section, type in the email addresses that are to receive the 
PolyWorks|DataLoop system error reports in Emails. Use a semicolon to separate the email 
addresses listed.

2. Click Send test email to send a test email using the configured outgoing email server 
address to all the emails listed in the Technical contacts section.

3. To send emails when the storage space used by the database exceeds a certain limit, go to 
the FILESTREAM storage space section to select Send emails to technical contacts when 
used storage space is above size limit and type in the desired size limit in Size limit in GB. 
The space currently used by the database is displayed. Note that this section is only 
available when using SQL Server FILESTREAM file storage.

4. In the Users mentioned in project discussions section, configure the emails sent for 
unread mention notifications in project discussions. The Send emails for unread 
notifications check box allows sending an email when a user is mentioned in a project 
discussion and does not read the notification for a certain number of minutes, as set in 
Delay (minutes).

5. Click Apply to save the configuration.

Note that the Configure outgoing email server link offers a shortcut to the Outgoing email 
server page of the System parameters tab. For more information, see Section 8.7 Configure 
the outgoing email server.
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8.14 Configuring the access of third-party client applications to 
the PolyWorks|DataLoop API
The ability of third-party client applications to connect to the PolyWorks|DataLoop API can be 
configured in the DataLoop API page of the Options tab.

By default, third-party client applications are allowed to connect to the PolyWorks|DataLoop 
metrology data API. To prevent them from doing so, proceed as follows:

1. Clear Authorize third-party client applications to connect to the DataLoop API.

2. Click Apply. 

After the change, current connections to third-party client applications will remain active until 
they expire. Afterward, when attempting a connection with a third-party client application, an 
error message is displayed.

Some endpoints of the PolyWorks|DataLoop API are now deprecated and set to be removed in 
PolyWorks|DataLoop 2026. They are disabled by default, but can be enabled if some scripts 
have not yet been adapted. To enable them:

1. Select Enable deprecated API endpoints that will be removed in DataLoop 2026.

2. Click Apply.

Note that the PolyWorks|DataLoop Metrology Data API and PolyWorks|DataLoop 
Administrative API URLs are also displayed on this page and can be copied as needed using 
the adjacent buttons.
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8.15 Getting help
The Help tab offers information about the current version of PolyWorks|DataLoop, copyright 
and trademarks, as well as links to pertinent technical documents and a way to save debug 
files.

Links to the following documents are offered:

 PolyWorks|DataLoop IT Administrator Guide

 PolyWorks|DataLoop Release Notes

 PolyWorks|DataLoop Core Third Party Notices

When investigating an issue, press Save debug files for support to create a zip file containing 
useful information that can be sent to support. It includes logs for all PolyWorks|DataLoop 
server applications.
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9. Setting up client applications
Once the PolyWorks|DataLoop server applications have been installed and configured, users 
can now connect to PolyWorks|DataLoop when using client applications.

Note that users are created and managed in the PolyWorks|DataLoop Core Administrator. For 
information on how to create users, refer to the PolyWorks|DataLoop Core Administrator User 
Guide.

9.1 The PolyWorks Metrology Suite
To connect the PolyWorks Metrology Suite applications to PolyWorks|DataLoop, proceed using 
one of the following two methods. 

9.1.1 Creating a new PolyWorks|DataLoop connection automatically from the 
PolyWorks|DataLoop Web Interface

The connection parameters can be automatically specified in the Workspace Manager by 
opening a project in the PolyWorks Metrology Suite from the PolyWorks|DataLoop Web 
Interface. 

To do so, click Open in PolyWorks|Inspector or Open in PolyWorks|Reviewer when viewing 
a project in PolyWorks|DataLoop Web Interface. When the project is opened in the 
corresponding module, a connection to PolyWorks|DataLoop is automatically established in 
the PolyWorks Metrology Suite, using the connection information from PolyWorks|DataLoop 
Web Interface.

This new connection is also added in the Workspace Manager and becomes the active 
connection. By default, the name of the connection is the Fully qualified domain name of the 
PolyWorks|DataLoop server and the specified connection method is Authentication via Web 
browser. 

9.1.2 Creating a new PolyWorks|DataLoop connection manually in the 
Workspace Manager options

The connection parameters can also be specified manually in the options of the Workspace 
Manager so that users can be connected to PolyWorks when using products of the PolyWorks 
Metrology Suite.

To specify this connection parameter, proceed as follows:

1. In the Workspace Manager, choose Tools > Options.
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The following dialog box is displayed.

2. Navigate to the PolyWorks|DataLoop page.

3. Select Manage PolyWorks data using DataLoop.

4. Keep piece templates available offline once opened, selected by default, allows keeping 
previously opened templates accessible even without a connection to 
PolyWorks|DataLoop. It is recommended to keep it selected.

5. Prompt to upload changes when closing a workspace, selected by default, allows 
receiving a warning message when closing a workspace that contains changes that were not 
uploaded to PolyWorks|DataLoop. It is recommended to keep it selected.

6. Create a new PolyWorks|DataLoop connection by clicking the Add button adjacent to the 
Active connection list, as shown to the right. 

Note that, if a connection was already configured before the 2022 IR5 version of PolyWorks, 
it is automatically added to the Active connection list as Default.
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The following dialog box is displayed.

7. Type in the name of the connection to be created in Connection name.

8. Type in the Fully qualified domain name of the PolyWorks|DataLoop server. This 
information can be obtained from PolyWorks|DataLoop Core Configurator. For more 
information, see Section 8.4 Configure the server FQDN and the PolyWorks Collaborative 
Suite License Server host. Once it is entered, DataLoop API URL is automatically filled. 

9. Click Test Connection to test if a connection can be established with the API. One of the 
following icons is displayed:

10. Select the desired type of login from the following:

 Authentication via Web browser - Connect to PolyWorks|DataLoop by entering the 
credentials on a page opened using the default Web browser.

 Current Windows session credentials - Connect to PolyWorks|DataLoop 
automatically using the current Windows session credentials.

 Reverse proxy with authentication - Connect to a PolyWorks|DataLoop server behind 
a reverse proxy with authentication by entering the credentials on a page opened using 
the default Web browser.

Indicates that the connection parameter was specified properly and that a 
connection can be established with the API.

Indicates that no connection could be established with the API. Make sure that 
you typed in the connection parameter properly. Then, try again.



PolyWorks|DataLoop - IT Administrator Guide 77

 DataLoop account - Connect to PolyWorks|DataLoop by entering the credentials of a 
DataLoop account.

By default, Authentication via Web browser is selected.

11. Click Create. 

The connection is added to the Active connection list.

12. Select the newly created connection in Active connection.

9.1.3 Logging in to PolyWorks|DataLoop from PolyWorks

As a result of selecting Manage PolyWorks data using PolyWorks|DataLoop in the options 
of the Workspace Manager, additional items related to PolyWorks|DataLoop are offered in the 
PolyWorks Metrology Suite. One of these items is the dialog box used to log in to 
PolyWorks|DataLoop.

To log in to PolyWorks|DataLoop from the PolyWorks Metrology Suite, proceed as follows:

1. In the Workspace Manager, click the connection button, which is located on the status bar.
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If the Current Windows session credentials or PolyWorks|DataLoop account login type 
has been selected in the options, one of the following dialog boxes is displayed.

If the authentication via Web browser or Reverse proxy with authentication login type 
has been selected in the Options, the default Web browser is opened and a page is 
displayed, such as the one shown below.

Note that, if an identity provider is configured, it is also offered on the page.

2. If needed, type in the user name and password in Username and Password.

3. Click Log In. 

The connection button, located on the status bar, indicates that a connection is established. 
You remain connected until you log out or close the Workspace Manager.

If a connection cannot be established, contact your IT administrators. Your connection 
parameter may not be specified properly, or servers may be down.

With Windows session credentials Without Windows session credentials
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9.2 PolyWorks|DataLoop Web Interface

9.2.1 Accessing the PolyWorks|DataLoop Web Interface

To access the web interface, users must type in the following URL in their web browser:

<FQDN>/polyworks/dataloop

where <FQDN> is the fully qualified domain name of the PolyWorks|DataLoop server.

9.3 PolyWorks|DataLoop Mobile Interface

9.3.1 Deploying the application on mobile devices

To obtain the application, download the PolyWorks|DataLoop application from the application 
store on your mobile device. 

9.3.2 Configuring the connection parameters to the server

To configure the connection parameters in the PolyWorks|DataLoop mobile application, 
proceed as follows:

1. Open the PolyWorks|DataLoop application on your mobile device.

2. Specify the PolyWorks|DataLoop Web Interface Server URL. An information button in the 
application shows where to find it.

3. Click Connect to server. 
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9.4 PolyWorks|ReportLoop for Excel (DataLoop)
The following schema shows how the PolyWorks|ReportLoop for Excel (DataLoop) connects to 
PolyWorks|DataLoop.

9.4.1 Deploying the add-in in the Microsoft 365 admin center

In order to be able to use PolyWorks|ReportLoop for Excel (DataLoop), the add-in must first 
have been deployed by the IT Team in the Microsoft 365 admin center. 

1. The XML file of the plug-in can be obtained in PolyWorks|DataLoop Core Configurator by 
opening the PolyWorks|ReportLoop for Excel page on the System parameters tab. Press 
Download manifest file.

2. Follow the Microsoft procedure described in the following link: 
https://docs.microsoft.com/en-us/microsoft-365/admin/manage/manage-deployment-of-
add-ins?view=o365-worldwide. Note that the Upload custom apps option must be selected 
for the deployment.

9.4.2 Adding the add-in in Excel for Microsoft 365

1. Click Add-ins on the Home tab.

https://docs.microsoft.com/en-us/microsoft-365/admin/manage/manage-deployment-of-add-ins?view=o365-worldwide
https://docs.microsoft.com/en-us/microsoft-365/admin/manage/manage-deployment-of-add-ins?view=o365-worldwide
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2. Click More Add-ins.

3. Go to the Admin managed tab and select the PolyWorks|ReportLoop for Excel 
(DataLoop) add-in in the list.

4. Click Add. 

PolyWorks|ReportLoop for Excel (DataLoop) can now be accessed in Microsoft Excel with a 
button on the Home tab.
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10. Upgrading PolyWorks|DataLoop server 
and client applications

10.1 Having a sandbox environment for testing (pre-
production/staging)
Prior to deploying any version to end users in their production environment, it is recommended 
to deploy new versions of software programs in a non-production environment, where it is 
possible to validate that the new versions will work as expected with the different hardware 
and software dependencies.

10.2 Creating a system backup 
Prior to upgrading PolyWorks|DataLoop, it is recommended to create a system backup (e.g., 
database backup or VM snapshot). 

Prior to upgrading PolyWorks|DataLoop, it is recommended to back up your 
PolyWorks|DataLoop server, your database, and any cloud block storage used. You must also 
back up your SQL database before your cloud block storage if you cannot back up both at the 
same time.

10.3 Validating requirements
The requirements should be validated prior to the deployment, especially important 
requirements such as:

 Operating system requirements

 PolyWorks software program compatibility

All requirements are detailed in the section 2. Requirements.

Note that the user who does the upgrade must have a SQL server role that allows altering the 
database, such as db_owner.

10.4 Scheduling and communicating the downtime
As deployments come with periods of downtime, users affected by the deployment should be 
warned in advance. Proactive deployment communications can confirm whether scheduled 
moments are good for users.

Moreover, affected users should be informed of the procedure to follow prior to the 
deployment. It is recommended that users disconnect from the PolyWorks|DataLoop server 
before the scheduled downtime.
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10.5 Upgrading the PolyWorks|DataLoop server applications
The required DataLoop server installer for upgrading the DataLoop server applications is 
provided in a ZIP file that can be downloaded from MyPolyWorks. 

10.5.1Launch the DataLoop server installer

To upgrade the DataLoop server applications as listed in Section 1.2 Server applications and 
required prerequisites, proceed as follows:

1. Launch the DataLoop server installer executable file (.exe). 

2. Click View license terms to open and read the license agreement in a separate window.

3. Click Agree and update to continue.

A window is displayed to show the progress of the installation.

As a result of the upgrade:

 The DataLoop server applications will be updated under the specified installation folder.

 The PolyWorks|DataLoop Core Configurator is opened.

10.6 Upgrading the schema using PolyWorks|DataLoop Core 
Configurator
The schema of the PolyWorks|DataLoop database must be upgraded after installing a new 
version of the PolyWorks|DataLoop server applications. This upgrade can be launched from 
the Schema version tab of the PolyWorks|DataLoop Core Configurator. It displays the current 
database schema version as well as information about a database upgrade when one is 
available. Note that the database cannot be accessed for the duration of the upgrade. 
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After the PolyWorks|DataLoop server application upgrade, the system may display a message 
indicating that the database needs to be upgraded. 

To upgrade the database, proceed as follows:

1. Prepare for the database upgrade. This includes reading the PolyWorks|DataLoop Release 
Notes, linked in the page, informing users to disconnect from PolyWorks|DataLoop for the 
duration of the update, backing up the database, and checking the compatibility of the new 
schema version with other PolyWorks products, as displayed.

Note that it is very important to back up the database before upgrading.

2. Click Upgrade database to launch the upgrade.

10.7 Updating client applications

10.7.1Updating the PolyWorks Metrology Suite client applications

The PolyWorks Metrology Suite applications should be upgraded following a DataLoop server 
upgrade. This will ensure that all the newest DataLoop features and security fixes are 
integrated in the PolyWorks Metrology Suite applications. 

Upgrading the PolyWorks Metrology Suite and PolyWorks|Reviewer consists of upgrading the 
application on all required client computers. If floating licenses are used and a new major 
version is deployed, the PolyWorks Metrology Suite License Server must be upgraded 
beforehand. 

For more information, refer to the “PolyWorks Installation Guide” PDF which is available on the 
MyPolyWorks customer portal or in the PolyWorks Metrology Suite ZIP package.

Note that you can use a older release of PolyWorks Metrology Suite applications with the latest 
release of the PolyWorks|DataLoop server application if the PolyWorks|DataLoop and 
PolyWorks Metrology Suite versions are compatible, as shown in Section 2.1.1 Interoperability 
with the PolyWorks Metrology Suite.

10.7.2Updating PolyWorks|DataLoop Mobile Interface

The PolyWorks|DataLoop Mobile Interface for Apple is automatically updated on the mobile 
devices on which the application was installed, if the device has access to internet and can 
connect to the App Store. 

The PolyWorks|DataLoop Mobile Interface for Android is automatically updated on the mobile 
devices on which the application was installed, if the device has access to internet and can 
connect to the Play Store. 
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10.7.3Updating PolyWorks|ReportLoop for Excel (DataLoop)

PolyWorks|ReportLoop for Excel (DataLoop) is automatically updated in the Excel application 
on which the add-in was installed.
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11. PolyWorks|DataLoop Frequently Asked 
Questions (FAQ)
The following sections provide common questions and answers for PolyWorks|DataLoop 
requirements, security and authentication, licensing, and log files.

11.1 DataLoop requirements
1. What do we need to set up a PolyWorks|DataLoop environment?

Besides a server (see Chapter 1. Overview of PolyWorks|DataLoop), PolyWorks|DataLoop 
requires an instance of Microsoft SQL Server 2017 or later, standard or enterprise version 
(see Chapter 3. Setting up Microsoft SQL Server). 

2. We already have an SQL Server instance, but of an older version. Will it work?

No, because we use features that are only available in the 2017 version or later.

3. Is SQL Server Express edition a possible option for us?

We do not support the use of SQL Server Express edition, because of its performance 
limitations.

4. Is there a difference between the Enterprise and the Standard editions of SQL Server 
besides the licensing cost?

Yes there is a difference between the two. The performance is not limited in Enterprise. But 
the main difference is the maintenance of your database. Enterprise edition will allow you 
to complete recurring maintenance of your PolyWork|DataLoop database without 
downtime. You will need to plan a time frame window with Standard edition for your 
recurring maintenance. The database will need to be locked until a specific task is complete. 
The time needed will depend on many factors.

5. Do you support SQL Server Always On?

SQL Server Always On is supported when file storage is using cloud services like AWS or 
Azure.

6. In terms of server storage, what provision should I make for PolyWorks|DataLoop?

Database and FILESTREAM storage depend essentially on the amount of data that you need 
to manage and how it will grow according to the future measurements and all uploads. For 
example, if you inspect many pieces using point cloud data, you will need more space. 

7. Can we use virtual environments?

Of course. You can use virtualization on premises or on the cloud. You can also use Amazon 
Web Services (AWS) or Microsoft Azure.

8. Can we use an RDS database on Amazon Web Services (AWS)?

Yes, but the file storage must not be FILESTREAM. Usually, Amazon S3 is used.
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9. Do you recommend a specific instance of Amazon Web Services (AWS) for 
PolyWorks|DataLoop?

Yes, see Section 2.3 Server requirements for more details.

10. Do you have a mobile application?

Yes, we have a mobile application for iOS and Android devices. Note that on any mobile 
device you can review the measurement results in a mobile HTML version of our web 
interface. This application allows you to view projects according to your privileges and lets 
you interact with others through the discussion feature.

11.2 Security and authentication
1. How does user authentication work in PolyWorks|DataLoop?

We currently offer three ways to connect:

 SAML2-compatible identity provider users: A centralized identity provider (like 
Microsoft Entra ID) can be used to allow single sign-on (SSO) access to 
PolyWorks|DataLoop. It allows leveraging the existing user accounts and group 
architecture. Access and permissions are configured using the groups already defined 
in the identity provider. A built-in Multiple Factor Authentication (MFA) is usually offered 
for increased security. The identity provider can also be used to provide access to people 
outside of the main organization, such as suppliers.

 Windows Domain users: A Windows domain must already be set up to use Windows 
domain users. The user will use their own credentials to log into PolyWorks|DataLoop. 
You will be able to manage them by group through your Active Directory. It will be easier 
for access and permissions. The security is increased since the password is never stored 
in SQL Server; it uses the current Windows session credentials to authenticate.

 DataLoop users: These are basic users. This type of user authentication is suitable if a 
Windows domain is not implemented in your enterprise or if you want to give access to 
non-domain users, such as suppliers or consultants. 

2. Are you storing usernames and passwords?

Usernames are logged into log files of the application for debugging purposes.

Passwords for users are encrypted on the database using industry standards.

3. Can we use a SSO authentication?

We support this type of authentication for PolyWorks|DataLoop via SAML identity 
providers.

4. Can we make our PolyWorks|DataLoop accessible from another location?

Yes, you can. But make sure your environment is secured. Here are examples of techniques 
used to secure an environment:

 IP filtering

 Reverse proxy with authentication
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NOTE: PolyWorks|DataLoop is transferring data, so the performance can be altered if 
connected to through a VPN connection.

5. Can I leave the firewall on?

Yes, you can leave the firewall on, but you must authorize some ports for 
PolyWorks|DataLoop data exchange. PolyWorks|DataLoop server applications need to 
communicate through port 443 (see Section 5.2 Configuring port requirements).

6. Do PolyWorks|DataLoop users have all the same rights?

By default, yes, but you will be able to narrow the permissions, rights, and privileges 
according to your enterprise needs. It is only a matter of defining them. Once defined, the 
PolyWorks|DataLoop Core Administrator, our web-based tool, will help you apply these 
specific permissions, rights, and privileges to users. Those permissions and privileges are 
based on the active directory users/groups or on the SQL Server users. 

7. Is there any risk of losing metrology data with PolyWorks|DataLoop?

There is always a data loss risk. But with PolyWorks|DataLoop, the risk is minimal if the 
basic SQL Server maintenance plan that we detailed is implemented. The data is stored in 
the database, but every metrology station can also have a part of the data stored in a cache 
on its computer.

8. Why does PolyWorks|DataLoop Web Interface require credentials for domain users; 
shouldn’t these users be automatically connected?

Yes, using the domain users of your Active Directory should automatically log the user into 
PolyWorks|DataLoop Web Interface.

In some circumstances, however, it does not. Validate in the intranet zone security settings 
that the User Authentication Logon is set to Automatic logon with current user name 
and password as follows:

This will need to be done on each computer, unless it is part of a group policy of your 
company.
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11.3 Licensing
1. Does PolyWorks|DataLoop refer to PolyWorks Metrology Suite License Server?

No, PolyWorks|DataLoop has its own license server, called the Collaborative Suite License 
Server. The license server is installed automatically by the DataLoop server installer 
alongside other DataLoop server applications

2. What is the licensing mechanism to be able to use DataLoop?

Once you get your PolyWorks|DataLoop registration license key, you will need to enter the 
license key in the Collaborative Suite License Server registration page. This license server 
will distribute license tokens to your users.

3. How do I register my license?

You will need to enter your registration key into the web-based server, and it will 
communicate with the InnovMetric server through the internet to make sure your license is 
valid and get all the information related to it, such as number of seats, products that are 
accessible and expiration date. Any changes to your license will be effective almost instantly. 
Increasing the number of seats or the new expiration date after renewal will be done by 
itself.

4. My organization does not authorize internet access on servers, will I be able to 
register?

Yes, letting the server access the internet for a minute while the server validates the license 
is an option. If it is still not possible, an offline registration is possible following the steps 
into the license server. A file exchange will be done between your organization and ours.

NOTE: For these two alternative ways of registration, the process will need to be done once 
more if any changes are made to your license, and at least once a year for renewal.

5. Can I be connected to PolyWorks|DataLoop more than once?

Yes, the Collaborative Suite License Server allows concurrent connections for each user 
account. The same user account can be logged in on a maximum of two devices 
simultaneously. The users will be informed when they are about to reach the limit and the 
access will be refused if it exceeds the maximum number of concurrent connections 
allowed. A connection is considered active when the user logs in. When the user logs out, 
that connection is released and is no longer considered active. A connection is also 
automatically released after one hour of inactivity.

6. What is your licensing model?



PolyWorks|DataLoop - IT Administrator Guide 90

Here is a diagram that illustrates how the licenses are managed in the server:

For more information on the requirements, the offline registration, or the administration 
instructions, see the PolyWorks Collaborative Suite License Server Installation Guide (.pdf) 
available on the Help menu of the application or on MyPolyWorks.

11.4 DataLoop information (log files)
1. How can we trace or resolve a possible problem with our PolyWorks|DataLoop 

ecosystem?

Every PolyWorks|DataLoop server application logs specific information such as warnings 
and errors. Those are log files and they can be accessed through the PolyWorks|DataLoop 
server itself. Some server applications log information by default, others need to be 
activated. 

Note that the log files for PolyWorks|DataLoop Core are limited to around 10 MB in size for 
each of its components.

The log file folders for each application can be found under C:\ProgramData\InnovMetric. 

2. Does PolyWorks|DataLoop transmit any information to InnovMetric?

No, all your data is at the security level that you wanted to give them. No data will be 
transmitted without your consent. Your data is your property, never ours. If you want to 
transmit data to us, it will be done manually. No logs or configurations will be transmitted 
to us, except a statistic log of the license server for our revenue-sharing program.
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Appendix A: Transition
This appendix is intended for organizations that were already using the PolyWorks Metrology 
Suite before purchasing PolyWorks|DataLoop. It explains the steps that must be followed to 
upload existing PolyWorks data to PolyWorks|DataLoop once IT administrators have set up 
PolyWorks|DataLoop.

Existing PolyWorks data must be uploaded to PolyWorks|DataLoop before anyone can start 
using the PolyWorks Metrology Suite with PolyWorks|DataLoop.

Nominate a transition team
Before proceeding with the transition to PolyWorks|DataLoop, you need to nominate a team to 
oversee the transition. This team should at least include the following members:

 IT administrator – An IT administrator is required to install and manage the infrastructure. 
Access to the original files should be limited once duplicates are uploaded to the server.

 PolyWorks administrator – A PolyWorks administrator is someone who has an advanced 
understanding of how the PolyWorks Metrology Suite is used within your organization. This 
person must be able to locate where workspaces are stored in your organization, and can 
decide what to do with them. This person will be responsible to manage users, permissions 
and workspaces on DataLoop.

 Manager – A manager is required to represent PolyWorks|DataLoop users who are not 
users of the PolyWorks Metrology Suite within your organization. This manager needs to be 
informed of where projects are stored and how to access them, and is responsible for 
sharing this information with other users.

Prepare a transition plan
PolyWorks data that must be uploaded to the server is stored in workspaces. To perform the 
upload operation, the first step is to locate where existing workspaces are stored in your 
organization and to identify which ones you want to upload to the server.

If your organization has a large number of workspaces, you need to plan the transition to 
PolyWorks|DataLoop carefully. This will avoid confusion as well as the potential duplication of 
workspaces on the server.

If desired, you can upload your workspaces progressively, meaning that you can upload one set 
of workspaces at one point, and another one later. If you do this, make sure that PolyWorks 
Metrology Suite users within your organization are aware of your plan, and that they know 
which workspaces are shared using PolyWorks|DataLoop, and which ones are not.

It is not possible to merge pieces into the same inspection project if they are stored in different 
workspaces. For instance, it is not possible to upload a piece from a workspace that has never 
been uploaded to the server into another workspace that has already been uploaded, even if 
the workspaces or projects have the same name.

If you have a huge number of workspaces and do not want to upload each workspace 
manually, it is recommended to use a script to automatically upload all your workspaces. For 
help on creating such a script, contact the Technical Support team of your PolyWorks provider.
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Limit access to the original copies

Duplicate copies of workspaces may be created as part of the upload operation. In such cases, 
the original copies, which are the ones that are not uploaded to the server, must no longer be 
used. Users must always open files from the server in order to ensure that they collaborate on 
the same files. 

As part of your transition plan, you must therefore limit access to the original copies once 
duplicates are uploaded to the server. It is recommended to limit access as follows:

 For users, completely remove access to the original copies

 For a limited group (such as IT administrators), give read-only access to the original copies

In addition, it is good practice to keep the original copies as a backup, in case a mistake is made 
during the transition period (for example, a workspace is deleted from the server by mistake). 
Once you have thoroughly verified your PolyWorks|DataLoop setup, you may delete the 
original copies from your servers and store them on an external drive or on a tape drive.

Specify the Workspace folder
Once you have identified which workspaces you want to upload, you must specify the 
Workspace folder—a dedicated folder whose purpose is to share data with the server—on the 
computer from which you want to perform the upload operation.

To specify the Workspaces folder, proceed as follows:

1. In the Workspace Manager, choose Tools > Options.

The General options page is displayed.

2. Type in the Workspace folder name 
in Workspace, or click the adjacent 
button to browse for the desired 
folder.

 This folder must not be shared 
with multiple users using a 
network drive, as it could lead to data loss and corruption. Choosing a folder on a local 
drive is therefore a good practice.

 Better performance can be achieved by choosing a folder on a solid-state drive (SSD).
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Specify the connection parameters
A connection to the server is required in order to upload workspaces to the server. To establish 
a connection, you must specify connection parameters on the computer from which you want 
to perform the upload operation. 

This step should be performed by IT administrators, or they should provide you with the 
required connection information.

For detailed information, see Section 9.1 The PolyWorks Metrology Suite.

Establish a connection with PolyWorks|DataLoop
Once connection parameters are specified, a connection must be established with the server in 
order to upload workspaces. To establish a connection with the server, Section 9.1.3 Logging in 
to PolyWorks|DataLoop from PolyWorks.

Upload workspaces to the server
Once a connection is established with the server, you must upload your workspaces. To do so, 
you must follow different steps depending on whether your workspaces are stored in the 
Workspace folder, or elsewhere. The subsections that follow provide a procedure for each 
case.

If required during the upload operation, the PolyWorks Metrology Suite automatically creates 
copies of workspaces in the Workspace folder. It is recommended to let the PolyWorks 
Metrology Suite copy and duplicate your workspaces. If, however, you want to copy them 
manually before proceeding with the upload operation, proceed with caution to avoid 
corrupting workspaces. To do so, choose File > Save As in the Workspace Manager, and save a 
copy in the Workspace folder.

Workspaces already stored in the Workspace folder

To upload workspaces that are already stored in the Workspace folder, proceed as follows:

1. In the Workspace Manager, choose File > Open.
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The following dialog box is displayed.

2. In the search box, located in the top-left corner of the dialog box, type in information to find 
your workspace, such as its name.

3. Click Search.
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Results are displayed for workspaces stored in the Workspace folder (as well as for 
workspaces already uploaded to the server).

4. Select the thumbnail that corresponds to your workspace.

5. Click Open.

The workspace is opened in the Workspace Manager.

6. In the Workspace Manager, choose File > Upload to PolyWorks|DataLoop.
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The following dialog box is displayed.

7. Make sure that all check boxes are selected.

8. Click Upload.

The following dialog box is displayed. 

9. If desired, type in a message to be attached with the uploaded data.

10. If desired, change the security policy to assign to the workspace.

11. Click Upload.

The workspace is uploaded to the server.

12. Close the workspace.
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13. Repeat steps 1. to 12. for each workspace stored in the Workspace folder that you want to 
upload.

Workspaces stored in a different folder

To upload workspaces that are stored in a different folder than the Workspace folder, proceed 
as follows:

1. In the Workspace Manager, choose File > Open.

The following dialog box is displayed.

2. In the bottom-left corner, click Browse Local Files.
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A file browser is displayed.

3. Browse for the desired workspace, then select it.

4. Click Open.

The workspace is opened in the Workspace Manager.

5. In the Workspace Manager, choose File > Upload to PolyWorks|DataLoop.
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The following dialog box is displayed.

6. Make sure that all check boxes are selected.

7. Click Upload.

The following dialog box is displayed.

8. Click Copy. 

A duplicate of the workspace is copied to the Workspace folder, and the original copy is kept 
in its original location. 

9. Limit access to the original copy (see Limit access to the original copies).



PolyWorks|DataLoop - IT Administrator Guide 100

10. In the following dialog box that is displayed, type in a message to be attached with the 
uploaded data and change the security policy to assign to the workspace, if desired.

11. Click Upload.

The workspace is uploaded to the server.

12. Close the workspace.

13. Repeat steps 1. to 12. for each workspace stored in a different folder than the Workspace 
folder that you want to upload.
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Appendix B: Procedures to modify the 
database recovery model and manually free 
up space 

Freeing up space when using a database in full recovery model
It is possible to recover storage space with a database in full recovery model when deleting 
historical versions or permanently deleting workspaces. A backup with log truncation of the 
transaction log needs to be performed to remove the file references from the transaction logs.

Note that this functionality does not apply when using cloud storage, such as Amazon S3.
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After the backup has been performed, the following commands must be executed in SQL 
Server on the database:

CHECKPOINT

EXEC sp_filestream_force_garbage_collection

Consult the following Microsoft SQL documentation before using these commands:

Microsoft SQL Server - Checkpoint

Microsoft SQL Server - Filestream garbage collection

Note that Microsoft recommends running the sp_filestream_force_garbage_collection procedure 
twice in a row.

Changing the database recovery model from full to simple
In versions of PolyWorks|DataLoop earlier than 2022 IR5, the database was created using the 
full recovery model. To help recover storage space, the default recovery model is now simple. 

The recovery model of an existing database can be changed in Microsoft SQL Server 
Management Studio. Proceed as follows:

1. In the Object Explorer tree view, right-click the database and click Properties.

2. In the Options page, change the recovery model from Full to Simple.

3. Click OK.

https://docs.microsoft.com/en-us/sql/t-sql/language-elements/checkpoint-transact-sql?view=sql-server-ver15
https://docs.microsoft.com/en-us/sql/relational-databases/system-stored-procedures/filestream-and-filetable-sp-filestream-force-garbage-collection?view=sql-server-ver15
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Manually freeing up space when using a database in simple 
recovery model
Given as a Stored Procedure, the dl_mark_unused_files procedure requires no argument and can 
be run either manually or as part of a maintenance plan (see the Microsoft SQL documentation 
for more information). This procedure prepares unused files for their deletion.

Note that, for this procedure to work, the Version history must be enabled and the files to 
delete must have been unused for at least the number of days specified in the version history. 
Otherwise, the procedure cannot delete those files. The Version history can be set in the 
PolyWorks|DataLoop Core Configurator on the Version history page of the PolyWorks data 
tab. 

No data must be uploaded while this procedure is being performed.

Unused files are deleted during the normal operations of the Microsoft SQL Server. However, if 
space needs to be freed up immediately, the operation can be executed manually with the 
following Microsoft SQL commands:

CHECKPOINT

EXEC sp_filestream_force_garbage_collection

Consult the following Microsoft SQL documentation before using these commands:

Microsoft SQL Server - Checkpoint

Microsoft SQL Server - Filestream garbage collection

Note that Microsoft recommends running the sp_filestream_force_garbage_collection procedure 
twice in a row.

https://docs.microsoft.com/en-us/sql/t-sql/language-elements/checkpoint-transact-sql?view=sql-server-ver15
https://docs.microsoft.com/en-us/sql/relational-databases/system-stored-procedures/filestream-and-filetable-sp-filestream-force-garbage-collection?view=sql-server-ver15
https://docs.microsoft.com/en-us/sql/relational-databases/maintenance-plans/maintenance-plans?view=sql-server-ver15
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Appendix C: SQL Server Maintenance Plan 
for PolyWorks|DataLoop Database

There are multiple ways to perform an SQL Server maintenance plan. The following is a basic 
minimal maintenance plan for your PolyWorks|DataLoop SQL Server database. It is intended 
for your company's ITs and/or database administrator. It requires elevated privileges to 
complete each step. Before proceeding with the maintenance, make sure that you:

 Identify the SQL Server version you are using for the DataLoop database.

 Determine the best timeframe for the maintenance.

 Identify the maintenance operator to whom failure notifications will be sent.

 Obtain the maintenance plan credentials required to execute the plan's steps.

Note that we support the Standard and the Enterprise SQL Server editions. The major 
difference between the two, with respect to the maintenance plan, is that with the Enterprise 
edition, the maintenance can be performed online, without downtime. If you are on a 24/7 
schedule, this version is recommended. The Standard edition will entail some downtime during 
the indexes maintenance.

Maintenance plan steps

1. Check Database Integrity task

2. Indexes maintenance: 

 Rebuild Indexes task 

 Reorganize Indexes task

3. Update Statistics task

4. Backup steps: 

 Full Backup Database task

 Differential Backup Database task

 Database Checkpoint

 Transaction Log Backup Database

5. Cleanup tasks: 

 Backup files disk cleanup 

 Transaction Log disk cleanup 

 Job History cleanup
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PolyWorks|DataLoop SQL Server Database maintenance plan
Before performing the SQL Server maintenance, you must add the maintenance plan for your 
PolyWorks|DataLoop database. This plan will be used to add the following steps. 

To create a maintenance plan, proceed as follows:

1. In a new Subplan, add the Check Database Integrity task:

 Schedule: Once a week

 The run as credentials need to have enough privileges.

 Apply to System and DataLoop Database.

 Add a Notify Operator task upon failure.

** Note that this task validates checksums and indexes, no corrections will be made.

2. Indexes maintenance tasks:

2.1 In another Subplan, add a Rebuild Indexes task:

 Schedule: Daily, according to your maintenance timeframe (depending on the length of 
the operation; it will need to be executed once to know how long it will take).

1. Apply to the DataLoop Database.

2. Sort results in tempdb option: Enable this option only if the PolyWorks|DataLoop 
database is on a different disk than the tempdb.

3. Keep index online while reindexing option: Enable this option only if the running 
instance of SQL Server is an Enterprise edition. If you enable this option with a Standard 
Edition of SQL Server, the maintenance plan will fail.

4. Scan Type: Fast

5. Fragmentation: 30%

6. Page Count: 1000

7. Add a Notify Operator task upon failure.

2.2 In the same Subplan, add a Reorganize Indexes task (upon completion of the 
Rebuild Indexes task):

1. Apply to DataLoop Database.

2. Scan Type: Fast

3. Fragmentation: 15%

4. Page Count: 1000

5. Add a Notify Operator Task upon failure.

3. In a new Subplan, add an Update Statistics task:

 Schedule: Monthly (for example: on the first Saturday of each month, at midnight).

1. Apply to msdb, master and DataLoop Database.
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2. Update: All existing statistics.

3. Scan type: Full Scan.

4. Add a Notify Operator task upon failure.

4. Backup plan.

Be aware that the backup procedure must be adapted when using cloud storage, as the 
database backup will not include files. Verify with your cloud storage provider for 
instructions on how to obtain backups of files.

4.1 In a new maintenance plan, add a Backup Database task (Full):

 Schedule: Weekly

1. Backup type: FULL

2. Apply to DataLoop Database

3. Enable Create sub directories option.

4. Option: Compress Backup.

5. Can enable Verify backup Integrity (if enough time)

6. Add a Notify Operator task upon failure.

4.2 In a new maintenance plan, add Backup Database task (Differential):

 Schedule: Weekly (except the day of the full backup)

1. Backup type: Differential

2. Apply to DataLoop Database

3. Enable Create sub directories option.

4. Option: Compress Backup.

5. Can enable Verify backup Integrity (if enough time)

6. Add a Notify Operator task upon failure.

4.3 In a new maintenance plan, add a T-SQL Statement task:

 Schedule: Daily, every 15 minutes

1. Add the query: use dataloop_database 'checkpoint'

2. Needed to perform an effective transaction log backup.

4.4 In the same maintenance plan, add Backup Database task (Transaction Log):

1. Backup type: Transaction Log

2. Apply to DataLoop Database

3. Enable Create sub directories option.

4. Option: Compress Backup.

5. Disable Verify backup Integrity (the faster, the better)
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6. Add a Notify Operator task upon failure.

5. Cleanup tasks:

5.1 In a new maintenance plan, add Maintenance Cleanup task (Backup files):

 Schedule: Daily at midnight

1. Select the database backup folder.

2. Files extension: .bak

3. Include first-level sub folders.

4. Delete files older than: Select twice the length of your full backup, here in the example, 
it will be 2 weeks.

5. Add a Notify Operator task upon failure.

5.2 In the same maintenance plan, add a Maintenance Cleanup task (Transaction Log):

1. Select the database backup folder.

2. Files extension: .trn

3. Include first-level sub folders.

4. Delete files older than: Select twice the length of your differential backup, here in the 
example, it will be 2 days.

5. Add a Notify Operator task upon failure.

5.3 In a new maintenance plan, add a History Cleanup task (Backup files):

 Schedule: Monthly at midnight.

 Keep default settings:

1. Backup and restore history.

2. SQL Server Agent job history.

3. Maintenance plan history.

4. Remove older than 4 weeks.

These are the basic, but essential steps to follow in order to have a healthy effective database 
and be safe if a database restoration is ever needed.

References
More information is available at the following links:

https://docs.microsoft.com/en-us/sql/relational-databases/maintenance-plans/maintenance-
plans?view=sql-server-ver15

http://assets.red-gate.com/community/books/sql-server-maintenance-plans-brad-ebook.pdf

https://docs.microsoft.com/en-us/sql/relational-databases/maintenance-plans/maintenance-plans?view=sql-server-ver15
http://assets.red-gate.com/community/books/sql-server-maintenance-plans-brad-ebook.pdf
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Appendix D: FILESTREAM Split Storage 
There are two ways of performing a FILESTREAM split storage: 

 By adding Filestream_data files to an existing filegroup

 By adding FILESTREAM filegroups

The physical location where all these files and folders reside must be configured as High 
Availability, meaning at least be under failover power (battery backup) to be accessible at all 
times. Corruption may occur if the high availability is not met at all times.

Adding files to the existing filegroup
By default, the DataLoop database is set with 4 Filestream_data files. They are filled according 
to the SQL Server algorithm that ensures that they are filled linearly, as equally as possible. 
When adding a new Filestream_data file to your database, SQL Server will try to fill the new file 
to be equal to the existing files. 

A network drive for the new file is not recommended for performance reasons. Only local drive 
locations should be used.

Adding FILESTREAM filegroups
When adding a new FILESTREAM filegroup, a partition function can be created. Partitioning 
allows to determine where the files should go. If the current filegroup has exceeded a certain 
threshold, the file will be sent to the newly added filegroup; this can affect the performance if 
performed over the network on a NAS (enabling the UNC path will be needed). Do not forget to 
meet the high availability for this network drive.

This is the pattern of a standard DataLoop configuration:

With the new filegroup, it will interact as shown below:
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The simple partitioning strategy here is to add a new filegroup to store large files.

We developed two scripts to create the new partitioning.

Note: These scripts should only be executed by your database administrator (DBA) or by an IT 
resource who understands all the implications of each script. A full backup of your DataLoop 
database should be done prior to executing the scripts.

First script: Creating a new filegroup 

-- =========================================

-- Activate a partition scheme based on filesize to affect files to filegroups

--

-- Use the Specify Values for Template Parameters command (Ctrl-Shift-M) to fill in the 
parameter values below.

======================== 

USE <Database, sysname, DataLoop DB>

GO 

-- Creation of a FileGroup containing a folder

ALTER DATABASE <Database, sysname, > ADD FILEGROUP [BIGFILES] CONTAINS FILESTREAM;

ALTER DATABASE <Database, sysname, > ADD FILE(NAME = N'dl_0_big_files', FILENAME = N'<Big 
files folder, ,existing_folder>\<Database, sysname, >_0_big_files') TO FILEGROUP [BIGFILES];

GO 

-- Add filesize column to the File table

ALTER TABLE [dl].[File] ADD filesize BIGINT;

GO 

-- Compute size of files

UPDATE [dl].[File] set filesize = DATALENGTH(filedata)

GO 

-- Create partition based on filesize, moving files over newly created filegroup if needed

CREATE PARTITION FUNCTION FileSizePartFN(BIGINT) AS RANGE RIGHT FOR VALUES(<Size 
threshold in bytes, INTEGER ,100000>);

CREATE PARTITION SCHEME FileSizePartDataSC AS PARTITION FileSizePartFN TO([PRIMARY], 
[PRIMARY]);

CREATE PARTITION SCHEME FileSizePartFileSC AS PARTITION FileSizePartFN TO([FILES], 
[BIGFILES]);
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CREATE CLUSTERED INDEX IDX_size ON [dl].[File](filesize) ON FileSizePartDataSC(filesize) 
FILESTREAM_ON FileSizePartFileSC;

GO 

-- Activation of partition copy files instead of moving them. Delete old ones

CHECKPOINT

GO 

sp_filestream_force_garbage_collection

GO

Second script: Transfer large files

Once the first script has been run, you must run the following script to transfer the large files 
that were previously in the other filegroup.

Note: This script should only be executed by your database administrator (DBA) or by an IT 
resource who understands the implications of the script. Depending on how many large files 
there are to transfer from the current filegroup to the newly added one, this operation may 
take a long time. Therefore, the script should be executed when the server usage is at its 
lowest.

-- Compute size of new files

UPDATE [dl].[File] set filesize = DATALENGTH(filedata) WHERE filesize IS NULL

GO 

-- Delete old occurrences of file copied

CHECKPOINT

GO 

sp_filestream_force_garbage_collection

GO
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Appendix E: Authentication sequence for a 
DataLoop user from an identity provider
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Appendix F: Migration to cloud file storage
An existing database using FILESTREAM can be migrated to the cloud file storage method. Note 
the following:

 The bucket or container must be configured before starting the operation. For more 
information, see Section 4.2 Cloud storage.

 The migration process can require several hours, but PolyWorks|DataLoop remains usable 
for the whole duration of the operation.

Migration

1. On the Storage page of the System Parameters tab, click Migrate. The Migrate file storage 
dialog box is displayed.
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2. For Amazon S3, select Amazon S3 in Type and enter the name of the configured bucket in 
Bucket name. 

For Microsoft Azure Blob Storage, select Microsoft Azure Blob Storage in Type, then write 
the name of the configured storage account in Storage account name, and enter the name 
of the configured container in Container name. 

3. Click Test parameters. If everything is working correctly, Successful will be displayed.
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4. Press Migrate to launch the migration and close the dialog box. The progress of the 
migration is displayed on the Storage page of the System Parameters tab. 

5. If the migration needs to be paused at some point, click Pause migration. 

6. When the files are all migrated, a notification is displayed to invite you to finalize the 
migration. On the Storage page of the System Parameters tab, click Finalize migration.

Storage space on the database is freed and the migration process is completed.
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